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I was one of our nation�s hungry kids growing up. Today, 1 in 5 children in America 
struggle with hunger. But when they get breakfast, their days are bigger and brighter. 
Learning, attention, memory and mood improve. Together, we have the power to 
get breakfast to kids in your neighborhood � let�s make it happen. Go to hungeris.org 
and lend your time or your voice.



MacUser

5 ways to launch Mac apps from the
keyboard 7

How to turn on Twitter’s quality filters and
silence trolls 11

Barbra Streisand says Apple is updating 
Siri on Sept. 30 15

Apple Music is so good that I’m totally
trapped 19

MacUser Reviews 23

Hot Stuff 41

iOS Central

The best calendar apps 45

Apple advises immediate update to iOS
9.3.5 55

Apple’s new 2TB iCloud storage tier 61

Tested: 4 portable chargers for your
Apple Watch 65

iOS Central Reviews 75

What’s new at the App Store 87

iOS Accessories 88

Working Mac

How to use Optimized Storage in
macOS Sierra 109

End the clutter: How to organize your 
Mac menu bar 117

Hands on with Sierra’s Console 121

How to use Dictation on your Mac 125

Create

10 ways to make your outdoor photos
amazing 129

How to use Photoshop to turn a photo 
into a realistic painting 141

How to edit video in Photoshop CC 147

Help Desk

Mac 911: Sidebar shortcuts, fix an AirPort
Extreme, and find font characters 155

iPhone 7  
hands on  

92

Apple Watch 
hands on 
101

October 2016   CONTENTS
I N C O R P O R AT I N G  M AC U S E R

33



4

CCO & SVP, U.S. MEDIA AT IDG John Gallant

EDITOR IN CHIEF, CONSUMER BRANDS Jon Phillips

EXECUTIVE EDITOR Susie Ochs

DESIGN DIRECTOR Rob Schultz

Editorial

SENIOR EDITOR Roman Loyola 

ASSOCIATE MANAGING EDITOR Leah Yamshon

STAFF WRITERS Caitlin McGarry, Oscar Raymundo

SENIOR CONTRIBUTORS Adam C. Engst, Glenn Fleishman, Lex Friedman, Rob Griffiths,  
John Gruber, Jim Heid, Andy Ihnatko, Joe Kissell, Ted Landau, Rick LePage, Ben Long,  

Kirk McElhearn, John Moltz, John Siracusa, Derrick Story

COPY EDITOR Sue Voelkel

Design

DESIGNER Monica S. Lee

CONTRIBUTING PHOTOGRAPHER Peter Belanger

Advertising Sales

SALES MANAGER Duane Hampson 415/978-3133

Production

DIRECTOR, PRODUCTION Nancy Jonathans

INTERNATIONAL DATA GROUP CHAIRMAN OF THE BOARD  
Walter Boyd

IDG COMMUNICATIONS, INC. CEO  
Michael Friedenberg

MASTHEAD



5

HOW TO CONTACT MACWORLD SUBSCRIPTION SERVICES

Access your subscription account online—24 hours a day, 7 days a week—at www.macworld.com/customer_service or service.
macworld.com. You can use online subscription services to view your account status, change your address, pay your bill, renew 
your subscription, report a missing issue, get the answers to frequently asked questions, and much more. 

To start subscribing, visit subscribe.macworld.com. 

 U.S. MAIL Macworld Subscriptions Department 
  P.O. Box 37781, Boone, IA 50037-0781 
   (If you are writing about an existing account, please include your name and address at which you subscribe.)

 EMAIL  subhelp@macworld.com (Send your full name and the address at which you subscribe; do not send attachments.)

 FAX 515/432-6994

 PHONE 800/288-6848 from the U.S. and Canada; 515/243-3273 from all other locations 

The one-year (12-issue) subscription rate is $34.97; the two-year rate, $59.97; and the three-year rate, $79.97. Checks must 
be made payable in U.S. currency to Macworld. Please allow 3 to 6 weeks for changes to be made to an existing subscription.

MACWORLD EDITORIAL

The editors of Macworld welcome your tips, compliments, and complaints. Some stories and reviews from past issues can 
be located at www.macworld.com. We are unfortunately unable to look up stories from past issues; recommend products; or 
diagnose your Mac problems by phone, email, or fax. You can contact Apple toll-free, at 800/538-9696, or visit the company’s 
website, at www.apple.com. 

HOW TO CONTACT MACWORLD STAFF

Our offices are located at 501 Second Street, 6th Floor, San Francisco, CA 94107; phone, 415/243-0505; fax, 415/243-3545. 
Macworld staff can be reached by email at firstinitiallastname@macworld.com.

BACK ISSUES OF MACWORLD

Starting with the March 2003 Macworld, back issues can be downloaded in digital format, from www.zinio.com ($6.99; Mac OS 
X 10.1 or later required).  

REPRINTS AND PERMISSIONS

You must have permission before reproducing any material from Macworld. Send email to permissions@macworld.com; 
please include a phone number. 

MAILING LISTS

We periodically make lists of our customers available to mailers of goods and services that may interest you. If you do not wish to 
receive such mailings, write to us at Macworld, P.O. Box 37781, Boone, IA 50037-0781, or email us at subhelp@macworld.com.

PUBLICATION INFORMATION

October 2016, Volume 33, Issue 10 

Macworld is a publication of IDG Consumer & SMB, Inc., and International Data Group, Inc. Macworld is an independent 
journal not affiliated with Apple, Inc. Copyright © 2016, IDG Consumer & SMB, Inc. All rights reserved. Create, Playlist, 

Mac User, Macworld, and the Macworld logo are registered trademarks of International Data Group, Inc., and used under 
license by IDG Consumer & SMB, Inc. Apple, the Apple logo, Mac, and Macintosh are registered trademarks of Apple, Inc. 



Experience the world’s most amazing animals 

in one app. WWF TOGETHER – the new free app 

from World Wildlife Fund. Download it today. 

worldwildlife.org/together

THE CLOSER WE GET, THE MORE WE SEE



MACUSER News and Analysis About 
Macs, OS X, and AppleMACUSER News and Analysis About 
Macs, OS X, and Apple

5 ways to launch Mac apps 
from the keyboard
Your hands never have to leave the keyboard when you need to open an app.

BY KIRK MCELHEARN
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MACUSERMACUSER LAUNCH MAC APPS FROM THE KEYBOARD

Y
ou know how to launch Mac apps: you click an icon in 
the Dock, or you double-click an icon someplace else, 
such as in the Applications folder. But there are also a 
number of ways that you can launch apps without 

taking your hands off the keyboard. Here are five ways to launch 
Mac apps from the keyboard.

SPOTLIGHT

The simplest way to launch an app 

from the keyboard is to use Spotlight. 

Press the Spotlight keyboard short-

cut (by default this is Command-

Space) and type the first couple of 

letters of an app’s name. For exam-

ple, if you want to launch Safari, type 

saf. Spotlight should put Safari at 

the top of the list; press Return to 

launch it. If the app you want to 

launch isn’t the first one in the list, 

use the arrow keys to select it, and 

then press Return.

You don’t always need to type the 

first letters of an app’s name for it to 

USING SPOTLIGHT, you 

can quickly launch 

apps by typing a 

couple of letters.
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come up in Spotlight. If an app’s 

name has two words, such as 

GarageBand or Microsoft Word, you 

can type, for example, gb or mw to 

zero in on it.

LAUNCHPAD

Launchpad presents your apps with 

big icons on your screen, laid out in a 

similar way to iOS app icons on an 

iPad. To invoke Launchpad, press F4 

on newer Apple keyboards (older 

Apple keyboards use F4 to launch 

Dashboard); on a Trackpad, use a 

pinching motion with your thumb and 

three fingers.

You’ll see some of your app icons 

with a Search field above them. That 

Search field has focus; when you 

start typing, the characters automati-

cally get entered into that field. Type 

the first couple of characters of the 

WHEN YOU INVOKE 

Launchpad, the 

Search field is 

selected.
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name of the app you want to launch. 

If it is the first app selected, press 

Return to launch it. If not, use the 

arrow keys to select it, and then 

press Return.

APPLICATIONS FOLDER

Another way to launch apps from the 

keyboard is to do so in the Applica-

tions folder. It’s not that hard to get to 

that folder; in the Finder, just press 

Command-Shift-A. As with Spotlight 

and Launchpad, you can type letters 

to access your apps. However, typing 

in a Finder folder merely selects an 

item; it doesn’t hide other items in 

that folder, showing only the apps 

with the letters you type.

So, to launch an app such as 

Preview, type pr, and, unless you 

have another app whose name 

begins with those two letters, Pre-

view is selected. Press Command-

Down Arrow to open the app. Note 

that for apps with two-word names, 

such as QuickTime Player or System 

Preferences, you can’t type qp or sp. 

The Finder’s selection will jump to 

the second letter you type, so just 

type the first letter or letters, use the 

arrow keys if necessary to get the 

app you want, and then press Return.

FROM THE DOCK

You can navigate the Dock using the 

keyboard, and therefore launch any 

apps that are in the Dock. To do this, 

press Control-Fn-F3. If the Dock is 

hidden, it slides out onto the screen. 

Use the arrow keys to navigate the 

dock, or type the first letter of the 

app you want to launch. Press Return 

to launch the selected app. If you 

want to dismiss the Dock, press Esc.

USE A LAUNCHER

If you really want to use the keyboard 

to launch apps and do much more, 

you should probably look into using a 

launcher app. There are several of 

these: Alfred, Butler, LaunchBar, and 

Quicksilver. Choosing the Right 

Keyboard-based Utility (go.macworld.

com/launchers) 

discusses the 

different 

features of 

these launch-

ers.

The advan-

tage to using 

one of these 

utilities goes 

far beyond 

simply launching apps. You can 

control many of your Mac’s functions, 

navigate the file system, open, copy, 

move, and delete files, and much 

more.

With these five methods, you may 

find that launching apps is quicker 

and more efficient. You can use your 

keyboard more, and spend less time 

with your mouse or trackpad. ■

LAUNCH MAC APPS FROM THE KEYBOARD

IF YOU REALLY WANT 
TO USE THE KEYBOARD 
TO LAUNCH APPS AND 
DO MUCH MORE, YOU 
SHOULD PROBABLY 
LOOK INTO USING A 
LAUNCHER APP.
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How to turn on Twitter’s 
quality filters and silence trolls
Twitter has a solution for stopping the hate on its social network: put trolls in 
cones of silence.

BY IAN PAUL

11



The first new setting 

reduces the noise in your 

notifications stream. By 

default, anyone who 

mentions your Twitter 

username with the @ 

symbol shows up in your 

Twitter notifications. It 

doesn’t matter if they’re 

asking a simple question, 

offering constructive 

criticism, or threatening to 

cut your head off. Everyone shows up.

The new setting filters your 

notification down to solely people 

you follow. The new filter works on 

Twitter’s apps and the website. It’s 

not clear if third-party Twitter apps 

can also apply it.

Why this matters: Many—perhaps 

most—Twitter users don’t really have a 

need for this kind of filtering. But for 

people such as celebrities, politicians, 

or outspoken feminists, Twitter notifica-

tions can be a very dark place. For 

these people, personal threats and 

other objectionable comments from 

random Twitter users are common-

place. The new notifications filters will 

make Twitter a more hospitable place 

for anyone who wants to speak their 

mind without having to sort through a 

deluge of hate.

The unfortunate side effect of this, 

however, is that people who are 

being targeted for online harassment 

are effectively putting themselves in 

a bubble. In other words, the long-

held idea of using Twitter as an 

“online water cooler” to chat and 

share ideas with strangers will be 

over—if it ever truly existed in the 

first place.

IT’S ALL ABOUT QUALITY

The second new setting is called a 

TWITTER’S QUALITY FILTERSMACUSER

TWITTER’S TWO NEW 

notifications filters.

T
witter has finally come up with a solution to muzzle 
trolls. The company recently published a blog post 
announcing two new controls for filtering your 
notifications (go.macworld.com/filtertwitternot). 

Twitter notifications are the primary method through which 
trolls can contact and harass users.
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quality filter. This setting, which was 

turned on by default for my account, 

removes what Twitter calls “lower-

quality content.” This low-brow stuff 

can be things like duplicate tweets or 

bot-generated content. The quality 

filter affects your notifications and 

“other parts of your Twitter experi-

ence.” Presumably, that means your 

primary timeline. The low-quality filter 

never restricts people you follow or 

those whom you’ve recently inter-

acted with—don’t feed the trolls, folks.

HOW TO TURN ON THE  

NEW SETTINGS

Getting to the new settings is easy 

on Twitter’s website. First log in to 

the service and then click on the 

Notifications tab. To the right of your 

mentions, click the new Settings link.

Alternatively, you can navigate 

directly to twitter.com/settings/

notifications_timeline.

This settings area has two check 

boxes for filtering your tweets by 

people you follow as well as applying 

the quality filter. Check or uncheck 

whichever box you’d like, select Save 

changes, and you’re done. Accessing 

these settings via Twitter’s mobile apps 

is similar. Mobile users should also tap 

on Notifications and then tap the 

settings cog in that area, which takes 

you directly to the two new filters.

If you don’t see the new settings 

they may not yet be available for 

your account. Try updating your 

mobile apps or logging in to the 

website. If that doesn’t work sit tight; 

the new features should show up for 

you in the coming days.

If you apply the filter to only allow 

mentions from people you follow it’s 

also advisable to make sure your 

account restricts who can send you 

direct messages. You can double check 

this setting on Twitter.com by going to 

Settings → Security And Privacy.

Now let the haters keep on hatin’, 

because you’ll never know one way 

or the other. ■

CLICK THE Settings link 

in your Notifications 

tab on Twitter.com to 

get started.
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Barbra Streisand says Apple 
is updating Siri on Sept. 30
Siri just can’t seem to say her last name correctly, so Babs asked Tim Cook to 
fix it—and then leaked the alleged date when it’ll be done.

BY SUSIE OCHS
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M
emories…light  
the corners of 
AI…misty pro-
grammed memo-

ries…of how to say my name… 

Barbra Streisand has already given 

us so much: some of the best chick 

flicks of all time, like The Prince of 

Tides and oh, my God, The Way We 

Were; the term Streisand effect; Fifty 

studio albums; a fun new way to spell 

Barbara.

And now she’s getting Apple to  

fix Siri.

Well, a small part of Siri anyway. And 

she’s even told us when it’s suppos-

edly happening: in an iOS update 

allegedly coming September 30.

Seems that our Babs has taken 

umbrage with Siri’s pronunciation of 

her name: Apple’s assistant says 

“STRY-zand” instead of “STRY-sand.” 

(If you want to hear her butcher it 

yourself, ask Siri, “Who starred in The 

Prince of Tides?” Well, unless you’re 

Blythe Danner, in which case you 

might not want to hear how she says 

your name, either.)

WHEN SIRI GETS YOUR  

NAME WRONG

While you can teach Siri to correctly 

pronounce the names of people in 

your contacts list, the amazing Ms. 

Streisand doesn’t expect all of us to 

add her name to our digital Rolo-

dexes, although to be honest you 

could do worse.

Instead, Barbra went straight to 

the top. She appealed directly to Tim 

Cook. I mean, it’s been bugging her 

for years, that every time someone 

talks to Siri about Barbra Streisand 

and her incredible career, that 

conversation is just a little less 

illuminating than it should be, since 

people are left with the idea that 

maybe the second S in her surname 

has a little more Z sound to it than it 

actually should. It’s frustrating!

Tim Cook, gentleman that he is, 

agreed this should be fixed. And then 

our bestie Babs, duly excited as I’m 

sure we all would be, went on NPR 

(as you do), and spilled the happy 

beans. In an interview on Weekend 

Edition Saturday, she told Scott 

Simon that Apple would have an 

update for this pressing issue on 

September 30.

Wait, the last day of September? 

That would be a little unorthodox, 

SIRI UPDATEMACUSER
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since Apple usually releases a major 

version of iOS earlier in September, 

just before shipping the new 

iPhones. (That way, the new iPhones 

ship with the newest iOS.) Apple 

might have told Barbra that the 

update would be out by the end of 

September, or maybe the Siri Strei-

sand fix doesn’t go into effect with 

iOS 10, but rather a 10.0.1 update that 

will come along later in the month.

Either way, I’m stoked. People, 

people who use Siri, are the luckiest 

people in the world. ■



There  are  thousands  o f  s ib l ings  in  fos ter  care 

who  wi l l  t ake  you  jus t  as  you  are .

888. 200. 4005 AdoptUSKids.org
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Apple Music is so good that 
I’m totally trapped
Jason Snell doesn’t want to quit Apple Music—he’d have to buy a couple 
dozen albums, for starters.

BY JASON SNELL
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I was never comfortable with sub-

scription services. I was comfortable 

liking what I liked, and buying new 

stuff from familiar artists as well as 

new stuff from artists I discovered…

elsewhere, and didn’t see the value 

in an unending tap of music from 

every artist everywhere. The second 

was that I was concerned that by 

renting my music, I would end up 

trapped, with years of music discov-

ery that would disappear (or have to 

be purchased at a high price) if I 

decided to cancel my subscription.

APPLE MUSICMACUSER

DISCOVERING NEW 

MUSIC on a streaming 

service is great...and 

just makes it harder to 

leave without paying 

hundreds for all the 

new music you don’t 

want to live without. 

I 
always resisted joining a music-subscription service. My former 
Macworld colleague Chris Breen was always a fierce propo-
nent of them, first Rhapsody and then Spotify. (Now that Chris 
works at Apple, I assume he also likes Apple Music!)
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I’ve been a paying Apple Music 

subscriber for a year now, more or 

less, and I can report that my first 

complaint was completely wrong and 

my second was exactly right.

THE JOYS OF DISCOVERY

Let me get the good news out of the 

way first: I was completely wrong 

about my lack of interest in music 

discovery. The fact was, when I 

would contemplate discovering new 

music, I could never quite picture 

how that discovery would happen. 

Maybe a friend would recommend 

something? Maybe I’d hear some-

thing on the radio—which was a 

laugh, since I never listen to the 

radio…it would be like winning the 

lottery without ever buying a ticket. 

(My problems with the radio: ads, too 

much talking from people I don’t 

want to hear from about things I 

don’t care about, and the inability to 

skip songs I dislike.)

I discovered a band I like quite a 

lot, Say Anything, because I heard a 

track from their excellent album …Is a 

Real Boy on an episode of the NBC 

Sitcom Scrubs. As you do.

It began to dawn on me that I had 

a problem discovering new music 

when I used Pandora over a week-

end and ended up buying four or five 

albums from iTunes based on the 

music I heard. It was exhilarating and 

dangerous at the same time: I was 

discovering great new music that I 

liked! And then spending $50 in a 

couple of days to get it all.

Both sides of this equation are 

solved by a subscription service. 

Within a day or two of subscribing to 

Apple Music, I discovered its A-List 

playlists, curated lists of 50 current 

songs in specific genres. The Alter-

native A-List became a huge discov-

ery engine for me, leading me to 

discover great songs and artists and 

albums…all of which I could sample 

immediately, with no extra cost, 

because it was all part of my sub-

scription. My colleague Federico 

Viticci of MacStories had a similarly 

enlightening experience with Spo-

tify’s Discover Weekly.

In the past year I have discovered 

songs I love, new artists who are now 

among my favorites, and a lot 

more—all for the cost of that monthly 

subscription to Apple Music. In terms 

of the diversity of my music listening, 

I feel like I’m doing better than I’ve 

IT WAS EXHILARATING AND 
DANGEROUS AT THE SAME TIME: 
I WAS DISCOVERING GREAT NEW 
MUSIC THAT I LIKED! AND THEN 
SPENDING $50 IN A COUPLE OF 
DAYS TO GET IT ALL.
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done since the days I was a DJ at my 

high-school radio station.

A NICELY APPOINTED  

PRISON CELL

Now the bad news: I’m trapped now. 

Sure, I don’t have to stick with 

Apple—though if I were to switch to 

Spotify I’d need to make a bunch of 

notes so I could reconstruct my 

favorite playlists and add music back 

to my library. But if I were to decide 

that the life of a music-service 

subscriber wasn’t for me, that I didn’t 

want to pay that monthly fee, the 

costs would already be large, even 

after a single year.

In the past year I’ve added 338 

songs (including 22 full albums and a 

bunch of miscellaneous singles) to 

my music library, all via Apple Music 

and without buying anything. Even 

doing some triage to dump music 

that I wouldn’t really want to listen to 

again, it would cost me something 

like $250 to buy that stuff on iTunes 

or Amazon. That’s the buy-out fee for 

leaving a music-subscription service, 

after a year. And it’s only going to go 

up every year, with every discovery 

of something new and great, and 

with every new release from artists I 

already like. Within a few years, 

letting go of a music-subscription 

service will be unimaginable, even if I 

finally turn into a certifiable Old 

Person who no longer gets excited 

by new music.

What I’m 

saying is, Chris 

Breen was right, 

and so was I. 

The ability to 

have a spigot of 

music at the ready—pretty much 

anything you want to listen to, in full, 

in high quality, if you can conceive of 

it—is miraculous. It works for me, and 

it works for the music-mad teenager 

who now lives in my house.

But my trepidation that it would 

become addictive, a service too 

precious to ever abandon once I’d 

spent time with it…yeah, that turned 

out to be true, too. I was born and 

raised as a music consumer, buying 

tapes and CDs and MP3 downloads 

and adding them to my personal 

collection, but now I’ve embraced 

the subscription music future…and 

found myself trapped in it. It’s a 

luxurious sort of captivity, to be sure. 

But it’s captivity all the same. ■

APPLE MUSICMACUSER

NOW THE BAD NEWS: 
I’M TRAPPED NOW. 
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THINK YOU DON’T NEED extra software for managing Internet 

downloads? If your web browser gets only an occasional workout 

transferring files one at a time, you’re probably right. But if you 

frequently pull down multiple things at once, you could certainly 

benefit from a management utility.

In years past, the choice was simple: Yazsoft’s excellent Speed 

Download tackled everything you could throw at it with its familiar, 

DOWNLOAD UTILITY

FOLX 5: HOW I LEARNED TO  

STOP WORRYING AND LOVE THIS 

MAC DOWNLOAD MANAGER
BY J.R. BOOKWALTER

FOLX 5.0

mmmmh
AT A GLANCE

Folx 5 is a full-featured 
download manager for OS X, 
with smart tagging, wide 
browser support, and a built-in 
torrent client.

PROS

wide browser integration

unlocks YouTube downloads, 
scheduling, and more

CONS

upgrade

list of completed downloads

PRICE

COMPANY

Eltima Software

Reviews MAC GEMS ARE APPS THAT OFFER 

STANDOUT UTILITY OR UNIQUE 

FEATURES AT A GREAT PRICE.

The Latest Mac Products 

Reviewed & Rated
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iTunes-style user interface. But in early 2014, the developer suddenly 

called it quits. The application continued working until OS X El Capitan 

10.11, at which point I finally had to say goodbye.

Yazsoft did recommend an alternative to Speed Download, but it 

wasn’t quite the same. This supposed heir apparent wasn’t as user-

friendly, and worse yet, the user interface was downright ugly.

TRAFFIC COP

Folx is a free download manager (mac-downloader.com) I’ve tried 

several times since the demise of Speed Download, but could never 

warm up to. While cleaner overall, the UI deviated radically from what I 

was used to, brazenly flaunting a terribly out-of-place woodgrain back-

ground that hung around long after Apple’s obsession with skeuomor-

phism went out of style.

Earlier this year, Eltima Software announced the release of Folx 5 with 

a completely redesigned, Retina-friendly, and—at last!—eye-pleasing UI. 

But it’s not just the absence of that faux woodgrain that has made Folx a 

utility I have come to depend on daily.

REVIEWS  |  FOLX 5.0MACUSER

MANAGE FILE DOWNLOADS 

from the Internet in 

style with Folx 5, a free, 

lightweight Mac utility.
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For starters, Folx includes a 

plug-in to “catch” downloads 

from Safari, Chrome, Firefox, or 

Opera browsers, allowing the 

application to take over down-

loading chores. This is impor-

tant, because Folx splits trans-

fers across two threads to help 

pull files down faster; the 

plug-in also works more reliably 

than Speed Download ever did. 

If a download is interrupted for 

any reason, the software will 

automatically resume from 

where it left off.

In addition to managing 

browser downloads, Folx 5 is 

also a full-fledged torrent client 

with support for magnet links. I’ve always been partial to Transmission 

for downloading the occasional torrent, but Folx is more straightforward 

and easy to use. Downloads can also be assigned with one or more 

tags, making them easier to find in the list by clicking on only the entries 

you want to view.

BEFORE DOWNLOADING, 

users can select a range of 

options, including scheduling 

transfers for a later time, 

smart tags, and how many 

CPU threads to use to help 

speed up the process.

FOR COMPLETE CONTROL over 

transfers, use Folx 5’s Smart 

Speed setting or manually 

choose the speed on a case-

by-case basis.
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LIKE A PRO

As feature-packed as the free version is, the highly recommended $20 

Pro upgrade elevates Folx 5 to a must-have. Downloads can be split 

across up to 10 threads, with on-the-fly granular control over the desired 

transfer speed for each task by clicking on the gauge icon in the lower 

left corner. The upgrade also turns Folx into a YouTube downloader 

simply by pasting a URL and selecting the desired quality setting, which 

includes a handy audio-only option for music lovers.

Version 5.0 introduces a password manager, which has quickly 

become one of my favorite features. If you frequently download from 

websites that require authentication, being able to save and fill pass-

words is a huge time-saver, and Folx makes the process seamless and 

automatic; you can also manually add host, username, and password 

credentials as needed. (Free users can only save data for two websites, 

but there’s no limit for Pro upgraders.)

Perhaps the greatest argument for upgrading Folx is the ability to 

REVIEWS  |  FOLX 5.0MACUSER

WITH A $20 PRO upgrade, Folx 

5 can not only download 

torrents, but also search for 

them as well.
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schedule downloads for a more convenient 

time; late at night while you’re asleep, for 

example. This can be done on a case-by-

case basis as downloads are queued, or on 

a global basis from the Preferences panel. 

Eltima has thoughtfully added auto-com-

plete options to quit the application, sleep, 

or shut down the system when finished.

As much as my relationship with Folx has 

changed, there are a few things I’d still like 

to see. One is a button to clear completed 

downloads from the list with a single click; currently, you have to Con-

trol-Delete on the keyboard to accomplish this task. The menu-bar agent 

is also surprisingly sparse, and could benefit from controls for schedul-

ing, transfer speed, or a progress indicator for when the main app is 

hidden.

BOTTOM LINE

It took more than a fresh coat of UI paint to convert me into a Folx 5 

evangelist, but if you download Internet files with any kind of regularity, I 

recommend it highly—especially the Pro upgrade. ■

THE MENU-BAR AGENT IS 
ALSO SURPRISINGLY SPARSE, 
AND COULD BENEFIT 
FROM CONTROLS FOR 
SCHEDULING, TRANSFER 
SPEED, OR A PROGRESS 
INDICATOR FOR WHEN THE 
MAIN APP IS HIDDEN.



BACK IN THE pen-and-paper days, journaling required loads of 

effort. You needed to buy a dedicated notebook, keep it shielded 

from prying eyes, chronicle the day and date of each entry, and 

carve out a chunk of time to write in it.

Things are a whole lot easier now. Aside from the numerous 

note-takers that can double as a journal in a pinch, there are 

several apps dedicated to the fine art of chronological self-track-

ing. Led by the majestic Day One ($30 in the Mac App Store; go.

macworld.com/dayone), today’s digital journals are more than 

mere notepad imitators; with bold photos, location tracking, 

password encryption and powerful filters, they not only store your 

PRODUCTIVITY SOFTWARE

JOURNALY: A GOOD MAC 

JOURNAL APP THAT MIGHT BE 

GREAT ONE DAY
BY MICHAEL SIMON

JOURNALY 1.5

mmm
AT A GLANCE

Journaly isn’t as robust as 
some other journaling apps, 
but it has loads of potential.

PROS

CONS

PRICE WHEN RATED

$20

COMPANY

Emberify

MACUSER
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words, they actively encourage you to keep up the habit.

Journaly ($15; emberify.com/journaly) might not yet be a contender to 

Day One’s throne, but it arrives with loads of potential. Lightweight and 

versatile, it has the soul of an iOS app, but Emberify made the curious 

move to make it Mac-only. But even without the convenience of an 

iPhone app, Journaly is a decent entry to the fray that should get better 

with age, as long as its price doesn’t scare potential users away.

EASY WRITER

To get your creative juices flowing, Journaly utilizes a series of prompts 

designed to get you in the proper journal-writing frame of mind. Location, 

weather, and mood are included (the latter of which is designated by 

JOURNALY’S ENTRY SCREENS 

provide an at-a-glance 

overview of exactly how 

you felt when you sat 

down to write.
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emoji), but you can also add your own. Answers are pinned to the right 

side of the page, which brings a sense of uniformity to your journal, but a 

way to hide the fields on a per-entry basis would be a nice addition.

Elsewhere, Journaly doesn’t deploy any hidden sidebars or disap-

pearing panes of options, and in fact, there are barely any in-app 

preferences to speak of at all. While the content pane strikes a nice 

balance between minimal and crowded, customization is almost solely 

dedicated to expanding your content rather than changing how it looks. 

If you want to adjust the font or add emphasis, you’ll need to access the 

OS X contextual menu and utilize the standard tools.

Since Journaly doesn’t really feel like a text editor, the lack of Mark-

down support shouldn’t be a surprise, but still, the actual writing process 

is simple and straightforward. Inserting photos is a breeze, but unfortu-

nately you aren’t able to reposition them within the text or add captions.

WRITER’S BLOCKS

Journaly does a fine job with organizing your completed entries, which 

are arranged in a neat row with visible timestamps and pictures. If you 

can’t find what you’re looking for by scrolling, a live search bar will 

retrieve it in an instant. There’s also iCloud sync support (though without 

an iOS companion, it’s really only useful if you have two Macs), optional 

REVIEWS  |  JOURNALY 1.5MACUSER

PICTURES, TAGS, AND 

live search keep your 

journal entries neat 

and organized.

30



password protection, and data exporting.

If it seems like there’s an overabundance of criticism about Journaly, 

it’s mainly because of how much better it should be for its cost. It’s a fun, 

unique take on journaling, but a $20 price tag (at the time of this writing, 

there’s a introductory 25 percent off deal, which makes the app $15) 

comes with certain expectations. While Journaly mostly meets them 

where it counts, there’s a constant sense that it’s not quite all it could be.

Take this example: Each time you write an entry you’ll need to press 

the save button when finished, and if you don’t, a dialog box will warn 

you that your work will be deleted, without actually offering an option to 

save it. Like many of the quibbles here, it’s not so much a nuisance as it 

is a wrinkle that diminishes the experience and distracts too much from 

the things it does well.

BOTTOM LINE

Journaly has a good concept and design, but its price doesn’t always 

jibe with its performance. ■

YOU CAN’T CHANGE the font 

or theme, but Journaly’s 

settings let you back up 

and secure your private 

thoughts.
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KENSINGTON 

SD1500 USB-C 

UNIVERSAL MOBILE 

DOCKING STATION

mmmm
PROS

CONS

PRICE WHEN RATED

$89

COMPANY

THE KENSINGTON SD1500 USB-C Mobile Dock ($89.99 MSRP; go.

macworld.com/sd1500dock; $80 on Amazon; go.macworld.com/

sd1500docamz) is another in an ever-larger collection of docks 

intended for Apple’s MacBook and for other USB-C–equipped devices.

The SD1500 combines 4K monitor support (over HDMI), gigabit 

ethernet, USB 3.0, and VGA video. What it doesn’t have is power 

pass-through. It’s clearly intended as a dock you throw in a bag to 

use for presentations, but not for a working day at a desk. The built-in 

USB DOCK

KENSINGTON SD1500 USB-C 

MOBILE DOCK: GREAT FOR THE 

TRAVELING MACBOOK PRESENTER
BY GLENN FLEISHMAN

MACUSER
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cord neatly bends into a curved slot for storage.

The combination of VGA and 4K makes the SD1500 stand out from 

some other docks that feature just an HDMI or DisplayPort connection. 

VGA is still widely used in corporate conference rooms and classrooms, 

and it’s clear Kensington knows that market. Adding gigabit ethernet—

which tested out at nearly the maximum possible throughput rate—is 

another nod to that environment, in which a wired connection might be 

preferable and available. (A driver has to be downloaded and installed to 

allow some OS X network operations while the computer is sleeping, but 

networking works without it, too.)

The USB 3 port gave me some trouble. I wanted to test throughput 

with both a 4K monitor connected and without, as USB-C has to commit 

some data lanes to DisplayPort video traffic for higher-resolution dis-

plays, and that in turn can reduce USB 3.0 rates to 2.0. Because of how 

the MacBook is set up, I didn’t see a reduction in USB 3.0 speeds, but I 

wasn’t able to get a MyDigital OTG USB 3.0 drive to work consistently 

with benchmarking apps.

During testing the SSD repeatedly would stall and then drop off the 

bus. I contacted Kensington, which tried to duplicate the problem with 

other brands of SSD, and sent me the reports; they had no problems. I 

tested the same SSD with a USB-C to Type-A (female) adapter from 

Apple connected to the same MacBook, and it tested out correctly. A 

hard drive I’ve used in previous USB 3.0 dock testing worked fine with 

the Kensington dock as well. I have to put this down to some firmware or 

interaction issue specific to the drive rather than the dock.
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Since the most likely use of the USB 3.0 port is for an external key-

board or other peripherals, drive reliability won’t be an issue for most 

people in any case, and the problem I experienced seems particular to 

the mode.

The SD1500 is tailored to an audience, and the $90 price reflects it. 

Because it lacks pass-through power, you have to fit the profile rather 

exactly of managing whatever you need to with just two to three hours 

of battery life, considering the drain may be faster if you’re running the 

video circuitry in your MacBook for a 4K monitor through the dock.

BOTTOM LINE

For the specific needs of the frequent video presenter, the Kensington 

SD1500 is the most compact, most versatile, and least complicated 

USB-C dock for the traveling MacBook user. ■

REVIEWS  |  KENSINGTON MOBILE DOCKING STATIONMACUSER
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FOR MANY MAC owners, the built-in Disk Utility is all they’ll ever 

need. After all, Apple’s software handles the basic task of formatting 

HFS+, FAT32, and exFAT volumes and partitions, along with the 

occasional need for one-click verification and repair of native OS X 

disks. (And with macOS Sierra, the RAID tools make a return; go.

macworld.com/configraidsierra.)

However, there are plenty of valid reasons for wanting to do more 

with your drives, and not all are exclusive to technically inclined 

STORAGE UTILITY

PARAGON HARD DISK MANAGER: 

TOTAL CONTROL OF YOUR MAC’S 

STORAGE DEVICES
BY J.R. BOOKWALTER

HARD DISK 

MANAGER FOR  

MAC 1.1

mmmmh
AT A GLANCE

Paragon Hard Disk Manager 
offers complete hard-disk 
management, including 
snapshot-based backup and 
recovery, the ability to create 
bootable media, and secure 
data wiping of any volume.

PROS

backup, restore

formatted for other file 
systems (Windows, Linux)

Recovery disk with one-click 

(recommended for advanced 
users only)

CONS

requires additional mouse 
clicks

displayed in some modes

backup

volumes

PRICE WHEN RATED

$40

COMPANY

Paragon



36

users. A few examples would be optimizing OS X, Windows, and Linux 

file systems, performing a secure wipe, or backing up data in a more 

effective manner than Time Machine.

If there’s anyone who knows what makes these file systems tick, it’s 

Paragon Software. Founded over two decades ago, the company makes 

it easy to format, read, and write NTFS or ExtFS volumes on a Mac with 

the simplicity and performance of native media. Now they’ve gone one 

step beyond those drivers with an all-in-one storage utility that makes 

Apple’s Disk Utility look positively feeble by comparison.

AT YOUR SERVICE

Making its debut on the Mac after years of services as a suite of Win-

dows tools, Paragon Hard Disk Manager (go.macworld.com/paragonhd-

REVIEWS  |  HARD DISK MANAGER FOR MAC 1.1MACUSER

PARAGON HARD DISK MANAGER 

offers total control over 

storage volumes for Mac, 

Windows, or Linux.
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mmac) is an impressively solid first-version OS X software. Functionality 

is divided across two tabs: Disks and Partitions, where the majority of 

storage management tools reside, or Backup and Restore, used to 

create snapshot-based archives.

Hard Disk Manager (HDM) is compatible with OS X Mavericks 10.9 and 

later, including support for the latest macOS Sierra courtesy of a free 

update. At first launch, HDM installs a few required under-the-hood 

“auxiliary components,” then displays a warning if System Integrity 

Protection (SIP) is enabled.

Introduced with OS X El Capitan 10.11, SIP prevents Mac software from 

gaining root privileges—great for combating potential malware, but a 

hindrance in the case of a utility like HDM. Senior contributor Glenn 

FOR ADVANCED USERS who 

want to get the most out of 

HDM, it’s easy to create a 

bootable OS X Recovery disk 

that can be used to disable 

Apple’s System Integrity 

Protection (SIP) for OS X El 

Capitan and later.



Fleishman explained how to manually disable SIP (go.macworld.com/

modifysipelcap) in a post last year, but HDM provides a one-click, 

Terminal-free method using bootable media that doubles as an OS X 

Recovery disk.

(A word of caution: SIP should only be disabled by advanced users 

who know what they’re doing and understand the risks associated with 

modifying system-level files. It’s not necessary or recommended for 

average Mac users.)

As a safeguard, HDM doesn’t immediately run most tasks, instead 

queuing them up awaiting further confirmation from the Apply Opera-

tions button before proceeding; there’s also an option to undo tasks 

from the queue. It’s great for preventing potential mistakes, but the extra 

clicks do tend to slow things down a bit.

REVIEWS  |  HARD DISK MANAGER FOR MAC 1.1MACUSER

WHETHER YOU NEED to 

format, partition, check 

file system integrity, or 

securely wipe one or 

more volumes, Paragon 

Hard Disk Manager is 

ready to serve.
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DISKS AND PARTITIONS

Like Disk Utility, HDM’s Disks And Partitions tab displays a list of all 

mounted volumes. But unlike Apple’s dumbed-down approach, HDM 

provides more-detailed disk maps, which represent partitions and logical 

disks as color-coded bars based on the file system in use: Purple for 

HFS+, light/dark blue for FAT16/32, aqua blue for NTFS, teal for exFAT, 

green for ExtFS, or orange for free space.

Needless to say, this approach is vastly superior to Disk Utility, which 

displays information by content type, like an iOS device. There are two 

ways to use the utility—you can wipe or copy an entire disk and edit 

sectors by clicking the gear in the upper right corner, or act upon 

individual partitions from their respective settings below.

HDM also displays partition information as a list at the bottom of the 

window, with available options only a contextual menu away. Oddly, this 

method doesn’t work from the graphical drive map, one of my few 

HARD DISK MANAGER uses 

Snapshot technology for 

sector-based backup and 

recovery that’s faster and 

more reliable than Time 

Machine.
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quibbles with an otherwise excellent utility.

Although HDM can format, partition, and work with non-native NTFS 

or ExFS volumes, you’ll still need Paragon’s replacement drivers installed 

to access files. Also, despite the name, HDM works equally well with 

solid-state storage (SSD), USB flash drives, and Apple’s hybrid Fusion 

Drives as it does with traditional platter-based disks.

BACKUP AND RESTORE

One of Paragon’s pride and joys is its Snapshot 

technology, which allows users to create an exact 

sector-level copy of the operating system and all 

user data. Compared to Time Machine and other 

Mac-native backup solutions, Snapshot offers 

improved performance, with system recovery times 

in minutes rather than hours.

The Backup and Restore options are laid out in a 

straightforward manner, and the Create New Archive 

wizard detects mounted OS X or Windows operating 

systems automatically, or you can manually select 

one or more partitions from the disk map. There’s 

currently no way to schedule backups as part of a regular routine, but 

Paragon plans to introduce this functionality in a future update.

HDM saves archives as Paragon Virtual Hard Drive (PVHD) images by 

default, which supports incremental imaging. This approach minimizes 

the time and storage space required for subsequent backups of the 

same volume(s). The installation also includes a VMDK mounter utility for 

those who prefer this format.

Paragon maintains a nice balance between ease of use and more 

advanced features, although novices will want to spend a little time 

getting accustomed to the unique UI before they start tinkering with 

existing volumes.

BOTTOM LINE

If you’re longing for the more robust features of earlier Disk Utility 

versions or want complete command over connected storage devices, 

Paragon Hard Disk Manager is the way to go. ■

REVIEWS  |  HARD DISK MANAGER FOR MAC 1.1MACUSER

COMPARED TO TIME 
MACHINE AND OTHER 
MAC-NATIVE BACKUP 
SOLUTIONS, SNAPSHOT 
OFFERS IMPROVED 
PERFORMANCE, WITH 
SYSTEM RECOVERY 
TIMES IN MINUTES 
RATHER THAN HOURS.
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What We’re 
Raving About
�is MonthHot Stuff

GRIFFIN TECHNOLOGY iTRIP  

CLIP BLUETOOTH ADAPTER

Griffin Technology’s $20 iTrip Clip (griffintech-

nology.com) is a Bluetooth adapter that gives 

corded headphones the wireless capabili-

ties needed to work with smart-

phones without head-

phone jacks, like the 

upcoming iPhone 7. It has a 

built-in mic so you can take 

calls or talk to Siri. Fully 

charged, this adapter can 

last up to six hours of play 

or talk time. Even if you 

don’t own corded headphones, the iTrip Clip 

has another surprising functionality. Hook it up 

to your car’s stereo system using an AUX 

cable, and just like that you can use Bluetooth 

to play music from your phone. —OSCAR RAYMUNDO
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Hot Stuff

WD MY PASSPORT WIRELESS PRO  

PORTABLE HARD DRIVE

Available in 2TB ($230) and 3TB ($250) capacities, WD’s My Passport 

Wireless Pro (wdc.com) will stream media via its 802.11ac hot spot for 

hours. It can also serve as a power bank for mobile devices. (If you’re 

new to wireless media-streaming hard drives, they’re basically a 

marriage of Wi-Fi hot spot and battery-powered USB storage.) Log 

onto the hot spot the My Passport Pro creates and you can stream 

music, video, or photographs from it to your MacBook, iPad, or iPhone. 

You can also use it like a NAS box or even a direct-attached USB 3.0 

portable hard drive. The My Passport Wireless Pro ameliorates every 

complaint we had about its predecessor. It has a lot more juice, it’s 

easy to use, and it has the ability to charge other devices. That’s as 

good as it gets in portable Wi-Fi drives. —JON L. JACOBI
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BOOQ COBRA SQUEEZE LAPTOP BACKPACK

Booq’s $195 Cobra Squeeze (booqbags.com) is the VW Beetle of 

laptop backpacks, using a dome shape so you can stuff as much as 

possible without creating weird bumps or needing an oversiz ed 

backpack. Its ability 

to be both compact 

and spacious at the 

same time was the 

most impressive 

aspect of all—the 

Cobra Squeeze 

could squeeze in 

even tight, crowded 

spaces like the 

subway or school 

hallways. The Cobra 

Squeeze has a 

dedicated laptop 

sleeve that can fit up to a 15-inch MacBook Pro. Then there’s a second 

sleeve for your iPad. On either side of the backpack, you’ll find easy-to-

reach zippers for storing your iPhone, and these side-pockets have 

extra padding to avoid scratches. Furthermore, the Cobra Squeeze 

uses a water-repellant fabric in case of a rainy day, and the company 

has instituted a serial number tracking system to help recuperate lost 

Booq bags, making them a worthwhile investment. —OSCAR RAYMUNDO



To donate or volunteer, go to UNITEDWAY.ORG. 

BECAUSE GREAT THINGS HAPPEN WHEN WE LIVE UNITED.

Thanks to our work with NFL PLAY 60, we’ve brought fun fi tness programs 

to more than 35,000 kids. And it can happen here too.

WHAT THIS PLACE NEEDS
IS ACTIVE PLAY EVERY DAY.
WHAT THIS PLACE NEEDS

IS ACTIVE PLAY EVERY DAY.



iOS CENTRAL �e Latest on the iPhone, iPad, 
iPod Touch, and App Store

The best calendar apps for the 
iPhone and iPad
With Sunrise scheduled to shut down soon, what calendar app 
should you get to replace it? Our list can help.

BY MICHAEL SIMON
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iOS CENTRAL THE BEST CALENDAR APPS

The best iOS calendars in the field 

don’t just look great, they offer their 

own unique concepts, distinguishing 

themselves by how they handle and 

present our data. Whether it’s event 

input, intelligence, social integration, 

or notifications, calendar app makers 

have added a wealth of features and 

functionality to the stock iOS calen-

dar, to the point where Apple has 

even begun to borrow popular 

features just to keep up. 

Nowhere is this more evident  

than in the impending shutdown of 

Sunrise (which was scheduled to  

fold on Aug. 31, but Microsoft stayed 

its execution go.macworld.com/

sun rise shutdown). When it launched 

back in 2012, it offered a refreshing 

spin on the classic calendar. With a 

variety of app integrations, it com-

bined events from places like Face-

book, Eventbrite, LinkedIn, and 

Foursquare to create a complete 

picture of your work and play com-

mitments. Smart, slick, and stylish, its 

color-coded events and minimal 

monthly view set a new standard for 

digital day planning, showcasing the 

enormous potential of multitouch and 

FANTASTICAL’S SLICK 

DESIGN gives you a 

tidy overview of your 

schedule, whether in 

day, week, or month 

view.

I
n the age of the iPhone, the art of managing a calendar is so 
efficient that we barely have to spend any time thinking about 
it. Like a high-priced personal assistant, our calendars work 
even when we’re not staying on top of them, dutifully pulling 

dates from emails and messages, and making sure we never 
forget a friend’s birthday. The smart, sophisticated iOS interface 
has turned calendar-keeping from an active, urgent responsibility 
into a passive one, and pretty much everyone who owns an 
iPhone now partakes in some form of day planning.
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the untapped power of iOS. A steady 

stream of updates made it one of the 

best and most popular calendars in 

the App Store until Microsoft bought 

it in 2015 and subsequently announced 

that Sunrise would shutter in August 

this year. The company delayed the 

move to bring more features to 

Microsoft’s Outlook email app.

But while bits of Sunrise can be 

found in Outlook, its influence can be 

felt on calendars all over the App 

Store. Its sleek design and unique 

concept paved the way for genera-

tions of digital day planners, and 

dejected devotees won’t have to 

look far to find a worthy replacement. 

Here’s our list of favorites. 

WINNER: FANTASTICAL

There are calendar apps, and then 

there is Fantastical (flexibits.com/

fantastical) ($5 for iPhone go.mac 

world.com/fantasticaliphone, $10 for 

iPad go.macworld.com/fantastical 

ipad). What started as a Mac utility for 

die-hard date keepers has turned 

into the measuring stick for all other 

mobile calendar apps. From its 

perfectly calibrated views to its 

downright pleasurable input screen, 

Fantastical doesn’t just live up to its 

lofty name—you’d be hard-pressed 

to find a flattering adjective that 

doesn’t apply.

Fantastical’s main screen has a 

definite Sunrise-style feel, with a 

chronological list of appointments 

displayed below a full or partial 

calendar month. Instead of a choose-

your-own-account method, Fantasti-

cal piggybacks on Calendar, display-

ing only the accounts you’ve 

subscribed to in Settings. Serious 

Eventbrite and Facebook users won’t 

miss the in-app integration, however, 

as they likely have those events 

already plugged into their Google or 

iCloud calendars.

Its interface is simple enough to 

THE DAYTICKER PUTS your events on full display, so 

you can check in and quickly get on with your day.
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grasp in seconds, but that’s not to 

imply that Fantastical is merely a 

basic calendar. There are three views 

to choose from: The patented 

DayTicker, which boils your calendar 

down to only days that have events, 

a full dot-style monthly calendar, and 

a week view that offers an hourly 

overview of your upcoming schedule. 

But while Fantastical can certainly 

function as a regular calendar, it’s not 

as much about days as it is about 

events. Where other calendars will 

show blank slots between appoint-

ments, Fantastical’s event list focuses 

solely on what you need to do. In 

fact, the only place you’ll see free 

time is in the weekly view, and that’s 

mainly for fixing scheduling snafus. 

It’s not unlike a to-do app in that 

regard, and it’s one of the many 

subtle ways that Fantastical sets 

itself apart from its competitors.

Event creation is an overlooked 

aspect of many calendar apps, but 

Flexibits spent considerable time on 

it. Foremost is its natural-language 

engine. It might not be as novel as it 

once was, but it’s still delightful to 

watch it parse a jumbled string of 

words into a sensible event. 

Fantastical requires separate 

purchases for the iPhone and iPad, 

but the money is well spent. Whether 

you have a mini or a Pro, Fantastical 

makes the most of the extra pixels, 

adding support for Split View and 

Slide Over, as well as an expanded 

design that puts a greater emphasis 

on the calendar. And if you own an 

Apple Watch, you can get reminders 

and add events right from your wrist. 

But the iPhone app is the star here, 

offering excellent on-the-spot event 

creation and at-a-glance scheduling 

all in one of the most beautiful inter-

faces you’re likely to find. And if that’s 

not fantastic, I don’t know what is. 

RUNNER-UP: CALENDARS 5

Readdle has been selling a calendar 

app for nearly as long as Apple has 

iOS CENTRAL THE BEST CALENDAR APPS

NO MATTER WHICH 

view you choose, 

Calendars 5 will give 

you complete control 

over your events.
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been making the iPad, and that 

experience can be felt all throughout 

Calendars 5 ($7) (go.macworld.com/

calendar5). Powerful, versatile, and 

just a little bit fun, the deluxe day 

planner will dutifully track your day 

with power and panache that defies 

its mobile status. 

A variety of views is common 

among most top-tier calendar apps, 

but Readdle leaves no stone 

unturned, offering calendars in all 

shapes and sizes: You can choose to 

see your day, week, or month; a list of 

your events; or filter down to just 

tasks. While you won’t find anything 

to rival Fantastical’s DayTicker among 

the fairly standard display options, its 

variety of views is a testament to just 

how well Calendars anticipates and 

responds to its users’ needs.

Like Fantastical, Calendars picks 

up all of your iCloud entries, but a 

separate sign-in gives Google users 

a bit more control over syncing. All 

of the usual features are present 

here—recurring events, reminders, 

alerts, etc.—but Calendars employs 

a natural intuition that makes the 

whole process quite enjoyable. For 

instance, you can tap on an event to 

open a floating window that will tell 

you more about it (or let you change 

something). Or double-tap a box 

when in full calendar mode to 

quickly shift to that day’s view. Or 

my favorite: If you want to resched-

ule an event, simply drag its tiny 

colored rectangle to a different 

date. 

And drag-and-drop isn’t the only 

desktop-caliber feature. Very little 

about Calendars feels much like a 

mobile app, and its utilitarian yet still 

elegant interface would be right at 

home on OS X. Even on the iPhone, 

Calendars’ user experience belies its 

tiny screen, with smart gestures and 

slick navigation that make scheduling 

a breeze.

When it comes to event creation, 

Calendars excels there too. While its 

EVEN WITHOUT DIALS 

or sliders, Calendars 

5 lets you create 

appointments quickly 

and easily.
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natural-language engine isn’t quite 

as mesmerizing as Fantastical’s, it 

does well to understand what you 

type or say, whether it’s a simple 

lunch meeting or a weekly task. And 

if you want to do things the old-fash-

ioned way, Calendars’ date selector 

is one of the best you’ll find, eschew-

ing dials for a grid method that 

eliminates any fumbling and lets you 

create even custom recurring events 

in seconds.

And that, in a nutshell, is Calen-

dars’ main appeal. Everything about 

it is designed for speed and simplic-

ity, and after using it for a few days, 

Calendars just might be the sole 

calendar you’ll ever need.

BEST FOR ANDROID 

SWITCHERS: GOOGLE 

CALENDAR 

When you’re in a strange land, a little 

familiarity is always welcome. The 

same is true with OSs. There might 

be a fair amount of overlap with 

Android and iOS, but switchers still 

have a lot of new stuff to learn. 

Thanks to Google, a calendar isn’t 

one of them. 

Google Calendar (go.macworld.

com/googlecal) on iOS (free, iPhone 

only) is pretty much a carbon copy of 

the version it offers for Android 

users. While it may look out of place 

next to the calendars here that follow 

Apple’s interface guidelines, 

Google’s Material Design isn’t 

without its charms. And with iOS’s 

lag-free scrolling and touch 

response, Android users might 

actually get a better experience than 

the one they’re used to.
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ANDROID SWITCHERS WILL instantly know their way 

around Google Calendar on the iPhone.
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But more than that, Google Calen-

dar is as good of a calendar on the 

iPhone as it is on a Galaxy. Switchers 

can see all of their appointments and 

birthdays without learning a new 

interface, and even veteran iPhone 

users will appreciate its colorful 

card-inspired look that gives  events 

an extra degree of glance-ability—

just so long as they don’t mind 

admitting that Android might not be 

all bad.

WITH NOTES, PHOTOS, and checklists, Informant will 

let you meticulously plan all of your events.

TIMEPAGE’S SLICK, CAREFREE interface is perfect for 

casual calendar keepers.
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BEST FOR LONG-TERM 

PLANNING: INFORMANT 

While any of the calendars here are 

as adept at planning next month’s 

vacation as they are with scheduling 

tomorrow’s business lunch, if you’re 

looking to chart out a serious long-

term life plan, they might not fit the 

bill. But Informant (go.macworld.com/

informant) (free to install, subscription 

required) will. Not only does it offer 

bountiful customization options that 

let you differentiate from things 



happening now and further down the 

road, it expands your events far 

beyond simply when and where they 

might be happening. If you’re sched-

uling a project, for example, you can 

add to-do reminders or you can 

easily attach a packing list to a future 

trip. You can also add memos and 

sub tasks to make sure nothing is 

forgotten. 

But what makes its planning 

abilities truly awesome is its text 

editing. Surely it’s not the only app to 

offer in-event notes (in fact, even 

Apple’s own calendar has them), but 

Informant’s text capabilities are more 

than a mere extra field. You can write 

and edit full pages of rich text and 

attach images to create a complete 

picture of your event. Informant’s 

iPad interface could use a little 

updating, but if you’re an obsessive 

long-term planner, its impressive 

tools and customization options will 

let you hammer out every last detail 

of your event.

BEST FOR SHORT-TERM 

PLANNING: TIMEPAGE 

If you only use your calendar for the 

most important events in your life, 

many of the apps here are probably 

too much calendar for your needs. 

But if you still want an alternative to 

Apple’s standard Calendar, Mole-

skine’s Timepage (go.macworld.com/

timepage) ($5, iPhone only) might be 

just the ticket. Straddling the ever-

thinning line between a to-do app 

and a calendar, Timepage doesn’t 

overwhelm you with features or 

options—rather, it offers an elegant 

spin on the day planner with a 

beautifully crafted, minimal interface.

Timepage utilizes a series of 

color-coded circles to illustrate your 

busiest days—a system vastly 

superior to the classic dot method, 

especially if you’re a casual calendar 

user. At a glance you can quickly see 
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IF YOU WANT to know what’s going on in the world 

around you, just give UpTo a pinch.

52



when your events are taking place, 

and scheduling a new one utilizes a 

delightful scroll bar that makes the 

process easy and fun. Events them-

selves get weather forecasts and 

travel estimates, all of which are also 

available on its companion Apple 

Watch app. 

BEST FOR YOUR  

SOCIAL LIFE: UPTO

No matter which calendar you choose 

to make your own, there’s one thing 

that’s consistent across all of them: 

CAL PUTS LESS of an emphasis on what you’re doing 

and more on who you’re doing it with.

53

They’re only as useful as the data you 

feed into them. UpTo (free, go.mac 

world. com/upto) takes a different 

approach. While you can use it to plan 

your schedule just like a regular 

calendar, it’s not just for tracking the 

things you have to do—it also keeps 

you up to date on stuff you want to do.

UpTo is kind of like a page-a-day 

calendar for the digital age. With a 

variety of community calendars to 

choose from, the app does a remark-

able job of turning your boring 

calendar into one you’ll want to visit 

each day. Along with your personal 

dates, UpTo shows you important 

dates in history, TV premiers, sport-

ing events, concerts, and anything 

else worth knowing about. And it 

doesn’t clutter up your calendar to 

do it—to access your social calendar, 

simply pinch out on your main 

calendar to see what’s happening in 

the world beyond your own.

OTHERS OF NOTE

Much like the hundreds of wall 

calendars that fill the shelves of that 

kiosk in your local mall each Decem-

ber, the App Store is loaded with 

more calendars than you can shake a 

stick at. And while there might not be 

any that feature tiny kittens doing 

adorable things, you’re almost certain 

to find one that fits your tastes.

Anyone who enjoys the sleek 

stylings of Any.DO’s task manage-



ment will love Cal’s (free, iPhone 

only, go.macworld.com/calapp) 

simple, breezy take on day planning. 

With a slick, speedy interface that 

puts a heavy focus on the people in 

your life, Cal turns calendar keeping 

from a chore into a downright 

pleasure.

If Cal isn’t minimal enough, Peek 

($3, iPhone only go.macworld.com/

peekcal) ditches the calendar format 

altogether. Clean and hyper-focused 

to the point where it barely looks like 

a calendar at all, Peek turns the 

traditional square grid on its head 

with a gesture-driven interface that 

will change the way you schedule 

and view your events.

If your life revolves around your 

calendar, 24me (free, (go.macworld.

com/24me) wants to be at the center 

of it. More than a calendar, 24me 

keeps tabs on all of the things you 

need to remember—dates, to-dos, 

lists, notes, and even bills—with a 

neat interface and a keen eye for 

organization. Like a personal assis-

tant, 24me gets smarter as you use it 

and makes sure you never forget or 

blow off an important event.

Several of the calendars here offer 

widget companions to their main 

calendar, but WidgetCal (free, go.

macworld.com/widgetcal) is devoted 

to it—and it shows. With a bright, 

colorful design and a surprising 

amount of customization, WidgetCal 

puts a complete picture of your life 

right in the Notification Center. And if 

it didn’t have to rely on Awesome 

Calendar (go.macworld.com/awe 

somecal) for inputting events, it 

would actually be powerful and 

flexible enough to be your main 

calendar.

That’s not to say being forced to 

use Awesome Calendar ($7) is a bad 

thing. Packed with loads of features, 

including to-dos, checklists, notes, 

and photos, the all-in-one scheduling 

app overcomes its somewhat stale 

interface by handling your tasks and 

events with swift precision. ■
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WIDGETCAL IS A MUST 

IF you spend a lot 

of time in your lock 

screen’s Notification 

Center.
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Apple advises 
immediate 
update to iOS 
9.3.5 after 
discovery of 
targeted 
iPhone 
spyware
Independent researchers tracked down malware sent 
to a Middle Eastern human-rights activist and alerted 
Apple, which patched three separate zero-day exploits.

BY GLENN FLEISHMAN
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A
pple released an update to iOS 9 on August 25—iOS 
9.3.5—that patches multiple critical zero-day vulner-
abilities that have been shown to already have been 
deployed, allegedly by governments to target activ-

ists and dissidents, according to a report from Citizen Lab and 
Lookout Security (go.macworld.com/iphonereport). Apple turned 
around an update within 10 days from when the company 
received Citizen Lab’s initial report. The update is recommended 
immediately for all iOS 9 devices. 

When used together, the exploits allow 

someone to hijack an iOS device and 

control or monitor it remotely. Hijack-

ers would have access to the device’s 

camera and microphone, and could 

capture audio calls even in otherwise 

end-to-end secured apps like Whats-

App. They could also grab stored 

images, track movements, and retrieve 

files.

Some of the exploits may have 

been discovered months ago or 

longer, so there’s no way to know 

how widely they’re in use, but details 

suggest these active exploits in 

previous versions of iOS 9 weren’t in 

wide use and were deployed against 

individual targets. 

“What we have seen from looking 

at these exploits is that it seems that 

they have been in the wild a bit 

longer than the 9.3.3/9.3.4 time-

frame,” report co-author Bill Marczak 

of Citizen Lab said in an interview. 

iOS 9.3.3 was released on July 18.

An Apple spokesperson said, “We 

were made aware of this vulnerability 

and immediately fixed it with iOS 

9.3.5. We advise all of our customers 

to always download the latest 

version of iOS to protect themselves 

against potential security exploits.” 

Apple later confirmed that an iOS 10 

beta released earlier in the week 

patched the same holes. The com-

pany declined to comment on 

whether iOS before version 9 remain 

affected, but noted 87 percent of iOS 

users run iOS 9 or later.

Jailbreaks have been demon-

strated but not yet released (go.

macworld.com/934jailbreak) for iOS 

9.3.4, and it’s possible those jail-

breaks relied on one or more aspects 

of the three flaws now patched. 

Zero-day exploits in iOS aren’t 

uncommon, based on efforts by 

jailbreakers, security researchers, and 

companies that sell flaws to govern-

ments (some of them selling to 

anyone who pays) at prices that can 

hit $500,000 to $1 million. However, 

iOS CENTRAL iOS 9.3.5 UPDATE
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this appears to be the first time the 

action of major active exploits was 

captured in the wild and thoroughly 

documented. Marczak said his 

organization had been tracking the 

infrastructure behind the exploit for 

some time before an activist for-

warded phishing links, which matched 

against a domain Citizen Lab had 

already been following. 

The odds of any combination of 

these exploits being used to hit iOS 

users broadly are very low, as any 

widely exploited bugs would have 

been observed by researchers and 

Apple. It’s most likely the flaws were 

kept close to the vest by any parties 

who discovered them, and were 

deployed for use only with high-

value subjects of government or 

criminal syndicate interest. 

As Lookout Security noted (go.

macworld.com/lookouttrident), “The 

going price for Pegasus [a mobile 

espionage product] was roughly $8 

million for 300 licenses, so it’s not 

likely to be used against an average 

mobile device user, only targets that 

can be considered of high value.” 

Nonetheless, it’s critical to install 

the update now that the exploits 

have been documented, as attackers 

may attempt to weaponize this 

approach for out-of-date devices. 

However, Marczak noted, “It was a 

fairly sophisticated exploit and we 

did omit some details about which 

functions were 

vulnerable,” so 

criminal 

organizations 

may not be 

able to take 

advantage 

before most 

iOS users have 

updated. 

Users should also avoid—now and 

forever!—clicking on links in SMS 

messages from unknown parties. 

Because SMS messages can be 

spoofed, it may be dangerous even 

from known parties.

HOW THE EXPLOITS WORK 

Citizen Lab is a project at the Univer-

sity of Toronto’s Munk School of 

Global Affairs, where researchers 

have looked into how power is 

exercised in digital realms, special-

izing in human rights and global 

security. The Citizen Lab report was 

conducted in collaboration with 

Lookout Security, and it builds on 

previous work the group did to chart 

the extent of a group it labeled 

Stealth Falcon (citizenlab.org/2016/ 

05/stealth-falcon)—which targeted 

internal and external critics of the 

United Arab Emirates (UAE) govern-

ment. While Citizen Lab had identi-

fied Stealth Falcon’s infrastructure, it 

hadn’t connected active malware 

with it.

USERS SHOULD ALSO 
AVOID—NOW AND 
FOREVER!—CLICKING 
ON LINKS IN SMS 
MESSAGES FROM 
UNKNOWN PARTIES. 
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On August 10, prominent UAE 

human-rights activist Ahmed Man-

soor received dubious SMS mes-

sages with links to click for informa-

tion ostensibly about abuses. 

Mansoor has been jailed, is banned 

from traveling outside the UAE, and 

is the victim of two previous so-called 

“lawful intercept” efforts. 

Lawful intercept refers to a 

government using the 

force of local law to obtain 

information from a net-

work, although the meth-

ods used may not always 

fit within statutory or 

constitutional protections 

in the country in which 

they occur. 

Rightly dubious, Mansoor for-

warded the messages to Citizen Lab, 

which then partnered with Lookout 

Security to test the malware, and 

identify three separate zero-day 

exploits—flaws that can be exploited 

in currently released software. Here’s 

how the chain of exploits work:

> The URL sent by SMS opens a 

webpage, which loads JavaScript 

and then retrieves remote binary files 

(available for both 32-bit and 64-bit 

versions of iOS). An exploit in the 

WebKit rendering component of iOS 

allows these binaries to execute 

within Safari.

> The executed binary uses an 

exploit that allows it to bypass a 

protection Apple uses within the 

operating system—Kernel Address 

Space Layout Randomization (or 

KASLR)—which should prevent 

malicious software from identifying 

where the core of the operating 

system is found running in memory.

> With the knowledge of where in 

memory the kernel can be found, a 

third exploit triggers, which corrupts 

memory in the kernel to disable iOS 

from blocking software from running 

that hasn’t been signed by Apple. 

This effectively jailbreaks the phone.

Researchers found that after these 

exploits were triggered in sequence, 

the executed binary then downloads 

and runs the spyware payload, which 

is designed to be persistent across 

rebooting iOS. It disables Apple’s 

automatic updates and removes 

other jailbreaks.

The report says the jailbreak 

installs hooks all over iOS to inter-

cept data, and specifically monitors 

for a number of apps, which include 

“iMessage, Gmail, Viber, Facebook, 

RESEARCHERS FOUND THAT AFTER 
THESE EXPLOITS WERE TRIGGERED IN 
SEQUENCE, THE EXECUTED BINARY THEN 
DOWNLOADS AND RUNS THE SPYWARE 
PAYLOAD, WHICH IS DESIGNED TO BE 
PERSISTENT ACROSS REBOOTING iOS.
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WhatsApp, Telegram, Skype, Line, 

KakaoTalk, WeChat, Surespot, Imo.im, 

Mail.Ru, Tango, VK, and Odnoklass-

niki.” The malware connects to 

remote command-and-control servers 

to exfiltrate captured data. 

Marczak said that a characteristic 

of highly targeted attacks is that URLs 

stop working after a single click, the 

intent being to infect one party and 

then be unavailable 

for further investiga-

tion. Marczak said 

they followed the link 

on a standard-issue 

iPhone and captured 

the infection process, 

but when the malware 

started to communi-

cate back to the 

operator’s server, he and his cowork-

ers became nervous about the 

microphone being enabled and GPS 

coordinates being transmitted.

“Very quickly, we turned it off and 

put it in a metal box,” Marczak’s 

colleague, Nick Weaver, said. “We 

didn’t want them to hear us giggling 

with glee.” 

Citizen Lab and Lookout Security 

connect the software with NSO 

Group, an Israel-based company that 

sells surveillance software to govern-

ments. The group is similar to Fin-

Fisher and Hacking Team, both of 

which firms’ software was previously 

used to target Mansoor. The report 

also includes evidence that ties the 

spyware installation attempt to the 

UAE government.

The report also ties an attempt a 

year ago in Mexico to target journalist 

Rafael Cabrera, who has reported on 

a conflict of interest involving the 

president of Mexico and the presi-

dent’s wife. While the links connected 

to those attempts weren’t serving 

malware, Cabrera 

provided Citizen Lab 

with more recent 

phishing attempts, 

which the researchers 

connected with servers 

they believe are 

operated by the NSO 

Group—and which, if 

the links were followed, 

would have resulted in infections. 

Marczak said that the software was 

designed to be used in stealth, 

monitoring data use and battery 

consumption to disable features that 

might show their hand. The software 

could also disable itself or remove 

itself entirely if an analysis environ-

ment was detected or remote opera-

tors wanted to pull the plug.

UPDATE YOUR DEVICE NOW

To install the update on your iOS 

device, launch the Settings app, then 

tap General → Software Update. You 

can also update within iTunes with 

your device connected to your Mac. ■
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Apple’s new 2TB iCloud 
storage tier will give your 
iPhone tons of space
The 2TB iCloud storage tier could signal the addition of 
a 256GB iPhone to Apple’s lineup.

BY CAITLIN McGARRY
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J
ust one week before Apple showed off the iPhone 7 and 
iPhone 7 Plus, the company launched a 2TB iCloud 
storage tier for $20 a month. That’s a significant amount 
of space, but Apple is reportedly gearing up to add a 

256GB option to its upcoming iPhone lineup. As 9to5Mac noted 
(go.macworld.com/9to5mac2tb), Apple typically offers iCloud 
storage plans that are eight times the size of the iPhone’s internal 
storage options. The iPhone 6s tops out at 128GB, and the previ-
ous iCloud storage max was 1TB.

Does that confirm a 256GB iPhone? 

No. Apple has a 256GB iPad already, 

so maybe its cloud storage options 

are finally catching up with Pro-level 

usage. The new Desktop and Docu-

ments feature (go.macworld.com/

deskdoc) coming in macOS Sierra is 

poised to eat up tons of iCloud Drive 

space if you use it to save files stored 

on your Desktop or in your Docu-

ments folder to the cloud.

If 2TB is way more than you’ll ever 

use, Apple is keeping its more 

modest storage plans, too, at the 

same prices: 50GB for $1/month, 

200GB for $3, and 1TB for $10. 

iOS CENTRAL 2TB iCLOUD STORAGE TIER

THE macOS SIERRA 

Desktop and 

Documents feature 

will automatically save 

files to iCloud.
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(Those prices apply to American 

iPhone owners—prices vary by 

country, and you can see the full list 

here (support.apple.com/en-us/

HT201238.) You get 5GB of iCloud 

space for free, as before.

The story behind the story: On 

Sept. 7, Apple took the wraps off its 

next-gen iPhones. The 7 Plus model 

will have a dramatically overhauled 

camera with two lenses, so that extra 

iCloud storage could be useful for all 

the high-quality images and 4K 

videos upgraders will be shooting. 

Also, Apple has dropped the base-

level 16GB iPhone after years of 

complaints about paltry storage. ■
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Tested: 4 portable chargers for 
your Apple Watch
Keep your Watch juiced all day long with these portable batteries.

BY SARAH JACOBSSON PUREWAL
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Sure, you can plug your charging 

cable into a regular portable battery, 

but do you really want to tote 

around a tangled, 2-meter-long 

charging cable? I didn’t think so.

This charging conundrum—cou-

pled with the fact that the Watch’s 

“all-day battery” isn’t quite as all-day 

as Apple would like you to believe—

has accessories companies scram-

bling for the perfect solution: 

portable wireless Apple Watch 

chargers. We tested four of these 

power banks, which are formulated 

specifically for the Apple Watch and 

its 2-meter-long charging cable, to 

see which ones will make your life 

easier and more powerful.

CLEARGRASS AMBER

ClearGrass’s Amber watchcase 

power bank (cleargrass.com/amber) 

has raised hundreds of thousands of 

dollars on both Kickstarter and 

Indiegogo, and the reason why is 

obvious: This portable charging case 

is functional, beautiful, and perfectly 

in line with Apple’s minimalist 

aesthetic.

The Amber is currently available 

iOS CENTRAL APPLE WATCH PORTABLE CHARGERS

K
eeping your Apple Watch powered on the go isn’t as easy 
as you’d think—especially since it can only be charged via 
Apple’s special magnetic charging puck.
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via pre-order, and will retail for $99. 

The case—a watch case/power 

bank—is made of anodized aluminum 

and plastic, and comes in four colors 

to match your Watch (silver, gold, 

rose gold, and space gray). The 

Amber measures 4x4 inches with 

rounded corners and is 1.75 inches 

thick, and weighs just shy of 10 

ounces. It’s a little clunky to stash in a 

purse or a briefcase, but it’s certainly 

small enough to tuck away in your 

suitcase for easy travel.

The top of the case has a single 

button that, when pressed, activates 

charging and displays the power 

bank’s current charge level (in five 

pinprick LEDs). The back of the case 

has two ports—a microUSB port for 

charging the internal battery, as well 

as a regular USB port that allows you 

to charge a non-Watch device (such 

as an iPhone) simultaneously.

The Amber opens with a hidden 

plastic hinge to reveal its semi-com-

plex charging setup. Like the other 

portable chargers we tested, the 

Amber is merely the power bank and 

does not include charging hardware—

in order to use the Amber, you’ll need 

to install your own magnetic charging 

cable. Installing the cable is fairly 

easy—just remove the plastic cover 

and the plastic spool, plug your cable 

into the hidden USB port inside the 

spool, and wind your cable tightly 

around it. The Amber can accommo-

date both the 1-meter and the 2-meter 

charging cables (though you’ll need to 

wind more precisely to make the 

2-meter cable fit). Once the cable is 

fully wound, place the charging puck 

in the circular indentation at the front 

of the spool and snap the spool into 

place.

To charge your Watch, place it 

against the charging puck inside the 
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Amber and press the button on the 

top of the case to activate charging. 

The Amber comes with a companion 

app that will notify you when your 

Watch is fully charged (the app can 

also be used to locate your Amber 

via phone). When your Watch is fully 

charged, the Amber will automati-

cally stop charging to save its 

internal battery life.

The Amber is both beautiful and 

functional, and it works exactly as 

advertised—as both a portable 

battery and a protective case for 

your Watch. (It’s also the only por-

table charger I tested that automati-

cally stops charging once your Watch 

hits 100 percent battery life, too.) The 

Amber packs a 3800 mAh internal 

battery, which should give you at 

least seven full Watch charges.

BOOSTCASE BLOC

Boostcase is known for its fashion-

forward tech accessories, and the 

Boostcase Bloc ($79.95 MSRP 

boostcase.com/shop)—a wireless 

Apple Watch dock with a built-in 

2,000 mAh battery—is no exception. 

The Bloc, which is made from pre-

mium materials and features exqui-

sitely precise craftsmanship, is 

actually designed as a stylish, wireless 

desk accessory—not a portable 

charger. But thanks to its built-in 

battery, it can be used as both.

The Bloc comes in three finishes: 

silver aluminum, space gray alumi-

num, and natural bamboo. This 

wireless charging dock is a simple 

block of metal or wood that measures 
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2.1 inches wide by 10 inches 

long, is just over half an inch 

thick, and weighs approxi-

mately 8 ounces. The center 

of the Bloc has a round 

cut-out for your magnetic 

charging puck (your Watch 

simply rests atop the Bloc 

while charging).

The Bloc is a dock and a 

portable battery in one, but to 

use it you will need to install 

your own magnetic charging 

cable. Installation is a little 

tricky because the Bloc is so 

precisely engineered—but it’s 

worth it. To install your cable, you’ll first 

need to seat your charging puck. The 

Bloc comes with two small silicone 

rings that fit around the puck (one fits 

the metal puck and one fits the plastic 

puck). Place the appropriate silicone 

ring around the puck and squeeze the 

puck into the round cut-out. This may 

take a few tries, but your puck should 

sit perfectly flush with the Bloc’s 

surface.

Once you have your charging 

puck seated in the Bloc, you can flip 

the device over and start carefully 

threading your cable along the 

precision-cut grooves. The grooves 

are exactly long enough to accom-

modate both the 1-meter and the 

2-meter charging cables (for the 

2-meter cable you’ll simply thread 

through the grooves twice). You can 

then plug your cable into the Bloc’s 

battery and start charging. The back 

of the battery has a microUSB  

port and three LEDs that indicate 

the current charge level. To see  

the current charge level, draw your 

finger along the battery’s touch-

sensitive panel.

The Bloc is a beautiful, elegant 

desktop accessory, but you’ll have 

some trouble using it as a portable 

charger because the Watch needs to 

lie flat on top of it—it’s not a protec-

tive case that you can close and toss 

into your bag. It is very slim, light-

weight, and portable, however, so as 

long as you have a flat surface, you 

can keep your Watch charged on the 

go. The built-in battery will give you 

at least four full Watch charges, and 

the battery itself can be removed if 
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you’d like to charge a different 

device (such as an iPhone).

NOMAD POD

Nomad’s Pod for Apple Watch 

($59.95 MSRP, hellonomad.com) is a 

compact wireless Apple Watch 

charger with a built-in 1800 mAh 

battery. The Pod is designed to be a 

travel companion—a small, portable 

battery that will keep you juiced up 

through a “long weekend” (you 

should get at least three full charges 

out of the Pod).

The Pod is the smallest and the 

lightest of the portable chargers we 

tested: It measures 3 inches in 

diameter, is 1 inch thick, and weighs 

4.7 ounces. It’s made of plastic and 

anodized aluminum, and comes in 

two finishes (silver and space gray). 

The Pod is approximately the same 

size and shape as a standard-issue 

hockey puck, with a hole in the top 

for your magnetic charging puck and 

a bottom that’s lined with rubbery 

non-slip material.

Like the other portable chargers 

we tested, the Pod is just a battery 

and requires that you install your 

own magnetic charging cable in 

order for it to be useful. The Pod 

accommodates both the 1-meter and 

the 2-meter charging cable, though 

the 2-meter charging cable is a 

pretty tight fit. To install the charging 
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cable, you will need to remove the 

Pod’s aluminum cover, which is 

attached with magnets. Inside, you’ll 

see a black plastic cable spool, a 

USB port, and a place to put the 

charging puck. First, you’ll plug your 

cable into the USB port and then 

you’ll wrap the cable around the 

spool, trying to keep it as snugly 

wound as possible. When you run 

out of cable you can place the 

charging puck in its seat and replace 

the aluminum cover. You may have to 

wrap the cable a couple of times to 

get the cable to fit.

On the side of the Pod there’s a 

microUSB port, a small power button, 

and four LEDs that indicate the Pod’s 

current charge status. To charge your 

Watch, simply place it atop the Pod and 

press the power button. The Pod will 

not stop charging once your Watch is 

fully charged, so you’ll want to remove 

it as soon as it hits 100 percent.

The Pod is a handy portable 

charger that can keep your Watch 

powered up throughout the day. While 

you can get at least three full charges 

out of the Pod’s modest battery, the 

fact that it doesn’t shut off after your 

Watch is done charging means you 

may get less. Like the Boostcase Bloc, 

the Pod requires a flat surface for 

charging (you can’t just toss it in your 
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bag and charge on the go). But if 

portability and size are a concern, the 

Pod is the charger for you.

UNITY POCKET

The Amber isn’t the only portable 

Apple Watch charger with crowd-

funding prowess—Unity’s Pocket 

(gowithunity.com) has also received 

hundreds of thousands of dollars 

from both Kickstarter and Indiegogo.

The Pocket, which is currently 

available for pre-order and will retail 

for $105, is billed as a 6-in-1 charging 

dock—where “6-in-1” is somewhat 

liberally defined. (Three of the 

Pocket’s six functions involve its use 

as a portable battery.) The Pocket is 

a charging dock and a protective 

Watch case, and it features a modu-

lar design that seems a bit overly 

complicated.

The Pocket is made of plastic and 

silicone with aluminum mesh 

accents. It’s a rectangular tower that 

measures 2.5 inches wide by 3.75 

inches long, and is 4 inches tall. For 

maximum versatility, the Pocket is 

modular and comes apart into five 

different pieces. It also ships with an 

additional silicone piece that helps 

turn the lid into a charging dock for 

your iPhone (more on this later).

There are three main sections to 

the Pocket: The top piece (the lid), 

the center piece (the cable manage-

ment piece), and the bottom piece 

(the battery). The lid is made of hard 

plastic and has Unity’s logo stamped 

across it. Remove the lid and turn it 
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upside down, and you’ll see a piece 

of silicone inside that acts as a stand 

for your iPhone. The separate piece 

of silicone that ships with the Pocket 

can be placed on top of this piece of 

silicone to make an elevated iPhone 

dock (with extra space underneath it 

to accommodate a charging cable). 

Noble idea, but who’s going to carry 

an extra piece of silicone around with 

them? Not me.

The center piece of the Pocket, or 

the cable management piece, is 

where you’ll place your magnetic 

charging cable. This piece comes 

apart into three separate pieces—the 

cover, which is accented with alumi-

num mesh that’s only half-attached to 

the body, the cable spool, and the 

dock for the charging puck. The 

cable spool is large and hollow 

(inside the cable spool is where your 

Watch will be stored), and fits both 

the 1-meter and the 2-meter charging 

cables. The dock for the charging 

puck is a small dome-shaped piece 

of silicone that rests atop the spool’s 

hollow interior. It’s not exactly 

precise, but it is flexible since it’s not 

attached to anything else.

Once you have your charging 

cable wound around the spool and 

the charging puck seated in the 

dock, you’ll need to plug the cable 

into the bottom piece of the Pocket—

the battery. The battery has a 
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microUSB port and a regular USB 

port, so you can charge non-Watch 

devices (such as an iPhone) simulta-

neously. It also has a power button 

and five LEDs that indicate charge 

status on the opposite side.

The Unity Pocket is an interesting 

concept—its modular design allows 

you to use it as many things, includ-

ing as a separate portable battery 

(you can remove the battery section), 

an iPhone dock, and a Watch char-

ger—but this product seems unfin-

ished. It’s certainly not as polished as 

the Amber charging case, nor is it as 

precisely manufactured as the Bloc. 

When your Watch is resting atop the 

precariously placed charging puck, 

you should be able to place the lid 

piece over it, but I found this to be 

difficult because the silicone piece 

inside the lid kept pressing on my 

Watch’s face.

The Pocket seems to be trying to 

do too much—an iPhone charging 

dock is a nice feature, but not at the 

expense of the Watch charging case. 

It’s also rather large and clunky (and 

the pieces come apart quite easily) to 

be ported around in a purse or a bag. 

The good news is that the Pocket 

does have the largest battery—4,200 

mAh—of the chargers I tested. This 

will get you 10 full Watch charges, so 

you can go a whole week without 

plugging in. ■
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PHOTOGRAPHY 

MICROSOFT PIX: iOS PHOTOGRAPHY 

APP USES ARTIFICIAL INTELLIGENCE 

TO RIVAL APPLE’S CAMERA
BY JACKIE DOVE

WHEN YOU SHOOT with the iPhone’s built-in Camera app, there are 

various ways to tweak focus and exposure, both before and after you 

hit the shutter. You might first tap and hold or swipe to adjust and lock 

focus and exposure. After the shot, you have options for adjusting 

saturation, contrast, sharpness, and more. That’s in addition to the 

optional HDR, or Live Picture settings and effects filters.

Microsoft Pix (free on the iTunes Store, go.macworld.com/pixapp), a 

Reviews
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photo and video shooting and editing app for iOS, doesn’t want you to 

work that hard. It offers an effortless point-and-shoot alternative to the 

iPhone Camera app with a promise of superior results.

BURST MODE

To accomplish that, Pix relies on AI-based algorithms to automatically 

adjust each shot on the fly, responding to lighting conditions and motion 

in a scene. The app fires off 10 shots in rapid succession, both before 

and after you tap the shutter. But it shows you only one to three of the 

best variations, letting you compare and select the one you like best. 

The other images are discarded, but only after the app mines them for 

elements to improve the chosen shot, including noise removal, face 

brightening, skin beautifying, and tone and color adjustment.

What really makes Pix stand out is its facial recognition tech, which 

not only zeroes in on human faces, but automatically prioritizes them for 

exposure and focus. The app’s algorithm favors faces with open eyes 

and smiles while rendering skin, foliage, and food in realistic hues.

In the real world, my results varied: Sometimes Pix improved on 

Apple’s Camera app and other times it didn’t. Some shots, especially 
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YOU CAN ACCESS your Camera Roll and view images and video shot with both Pix (left) and 

Camera (right).

PIX 1.09

mmmh
AT A GLANCE

If you don’t like fussing over 

camera settings, then you 

may like Pix, though its image 

quality is inconsistent.

PROS

adjust

faces and often does well in 

sharing tools

CONS

features

extreme low light shooting, 

images

PRICE

Free

COMPANY

Microsoft
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those taken in optimal, well-lit conditions look virtually identical, despite 

some slight color variations. Sometimes, Pix helpfully gave a face in 

partial shadow just enough illumination, though other times it overcom-

pensated by making faces a bit too bright, washed out, and flat. Some-

times Pix offers its best shot and an alternate or two, other times it just 

offered a single take.

If focus and exposure were similar, Pix helpfully straightened some 

photos that may have been shot at an angle, removed noisy artifacts, 

and helped to balance exposure on some backlit shots. Despite those 

fine qualities, I didn’t find Pix photos consistently better or more pleasing 

than those shot with Apple’s native app, and often could not tell them 

apart.

APPLE CAMERA (left), 

Pix (right).
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In extreme low light, Pix often performed poorly. While the Camera 

app can be set up to use the camera’s flash, Pix does not support flash 

on still images, only on video. In low light, the Retina Flash feature on the 

iPhone 6s models pushed the Camera image quality over the top in the 

selfie department, while low light Pix selfies taken with an iPhone 6 

showed better noise management than with the native app. Using auto 

flash on both an iPhone 6 and 6s offered better exposures than Pix 

without flash, though with flash turned off, Pix’s low light shots were 

brighter on the 6s.

LIVE IMAGE AND VIDEO

In addition to Pix automatically selecting and enhancing burst photos, 

the app also examines each frame to determine whether there’s enough 

motion to string them together into a cool looping video. If so, the app 

creates a Live Image, which is saved as a video file alongside your 

single shot.

Live Image is reminiscent of Apple’s Live Picture feature, which also 

starts recording before you tap on the shutter. With Live Image, Pix 

outputs a cinemagraph—a moving image comprised of a series of 

enhanced still shots stitched together—which is distinct from Apple’s 

video-based Live Photos because only part of a Pix Live Image moves, 
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PIX (RIGHT) HANDLED 

backlighting and face 

illumination better than 

Apple’s Camera app (left) in 

this case.
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while the rest remains static.

Unlike the Camera app, Pix creates cinemagraphs automatically 

without your having to enable the feature; it does not select every shot 

for Live Image treatment, only those with interesting movement. I 

noticed some ghosting on certain images, such as the movement of a 

cat’s tail or ears, which did not look pleasant. Live Image is enabled by 

default, but you can turn it off in the preferences.

Pix also integrates Microsoft’s Hyperlapse feature (distinct from 

Instagram’s app of the same name) into its video function, which auto-

matically stabilizes video and lets you record time-lapses that you can 

adjust to various speeds. You can even time-lapse or stabilize previously 

recorded footage with Pix. Note that the app supports 1080p video; but 

4k footage shot on your iPhone cannot be processed in Pix.

EASE OF USE

Despite a whole lot of computation going on in the background, Pix is 

drop dead simple to use. Just point the phone, decide what to shoot, tap 

the shutter, and the app takes care of the rest. Pix offers minimal mobile 

app editing tools but it does include the standard-issue effects filters 
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and supports sharing features. Since all images and videos shot with Pix 

also land in your Camera Roll, you can edit them further in Apple’s app 

or any other photo editor you choose. Performance was excellent, as the 

app zipped through its processes without a hitch.

BOTTOM LINE

In the end, users don’t care about a camera app’s underlying tech. It’s 

the final image that counts. In my experience, Pix worked well on some 

photos to improve face rendering, boost exposure, and fix composition 
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and backlighting. The hyperlapse video and cinemagraph features add 

to the app’s creativity. But it did not consistently outperform the iPhone’s 

built-in Camera app. Pix does offer meritorious results in some situa-

tions, so I recommend giving it a shot to see how it works for you.

That said, for those who truly do not want to deal with any before-shot 

prep or after-shot tweaking, Pix may be just the ticket. If you are using 

an older phone like the 5s or the 6, Pix lets you reap the benefit of a Live 

Photos-like feature that’s not included on your model. ■
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FITNESS TRACKER

SPIRE: KEEP CALM AND CARRY 

ON WITH THIS BEAUTIFUL 

BREATH-TRACKING DEVICE
BY CAITLIN McGARRY

FITNESS TRACKERS ARE a dime a dozen, but devices that focus on 

your mind instead of your body are typically overlooked—mental health 

is incredibly personal and can be difficult to define, which makes it 

even harder to measure. That’s what makes Spire (go.macworld.com/

spireamz), a breath-tracking device that aims to curb stress, stand out. 

This device was released in 2014 but got a boost this summer with an 

Apple Store retail presence and an overhauled iOS app, so I decided to 

give the company-described “mind and body tracker” a closer look to 

see if it really combats stress.

REVIEWSiOS CENTRAL
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Spire (spire.io) is a graphite-colored oval-shaped stone attached to a 

silver clip. You wear it on your pants or tucked inside your bra with the 

clip facing out. But its simple looks belie its more complex functions.

“What does that thing do?” my boyfriend asked as he watched me 

slide the device onto the waistband of my workout pants.

“Oh, it reminds me to breathe,” I replied without thinking.

“Um…your brain already does that,” he replied.

OK, true.

More specifically, Spire reminds you when to take deep, calming 

breaths in an effort to encourage more mindfulness. It’s also an activity 

tracker in that it counts your steps, but it’s not the best workout compan-

ion. It doesn’t have a display and it won’t urge you to run faster or get 

your heart rate up. Instead, Spire relies on its app to do the heavy lifting.

HOW IT WORKS

Setting up Spire is as easy as any other Bluetooth device. Make sure 

your phone’s Bluetooth is turned on, install the Spire app, and pair the 

device to your phone.

Spire is a beautiful device. It’s too bad no one will see you wearing it. 

The stone has to be touching your skin, which I somehow didn’t realize 

until hours into fastening it to my pants with the stone facing outward. I 

didn’t have any issues with friction when the stone was pressed against 

my skin, not even when running with Spire clipped inside my sports bra, 

but you’ll definitely feel that it’s there.

What Spire looks for is patterns in your breathing, which is why it has 

to be so close to your body. As you inhale and exhale, Spire tracks your 

chest movement, then sends that information to your phone. Your 

breathing appears in real-time on the app home screen as an undulating 

line. After you use the device for a few days, you’ll establish your 

individual baseline, so your breathing isn’t being compared to an 

average standard. Your breathing says a lot about your state of mind. 

Erratic breaths signal stress, while steady and slow ones indicate deep 

focus.

SMARTPHONE STRESS RELIEF

Because the device doesn’t have a display, you’ll need your phone 

nearby at all times to receive notifications, which are endlessly customiz-

SPIRE  

MINDFULNESS 

AND ACTIVITY 

TRACKER

mmm
AT A GLANCE

Spire is a well-designed 

device that encourages you 

to take deep breaths, but I’m 

not convinced it improves 

your mental health.

PROS

about mental wellbeing

CONS

tracker

PRICE

$129

COMPANY

Spire
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able. You can set your Spire to 

vibrate and send you an alert 

when you’ve been sitting for too 

long, when you need to take a 

deep breath, when you’ve been 

intensely focused for awhile, or 

when you’re in a sustained 

period of calm. All of these 

reminders are designed to make 

you more conscious of your 

breathing and your state of mind.

The app also integrates with 

your calendar, camera roll, and 

location, so you have a better 

idea of where and when you’re 

most stressed, focused, or calm. 

These integrations, which are 

new to the app, are a good start 

toward helping you figure out 

what triggers your stress before 

it happens. If a regular meeting 

with your boss throws you into 

tense mode, taking some deep 

breaths or meditating ahead of 

time could ease the stress.

Spire also has an Apple Watch 

app, so I was getting notifications 

all over the place. This is how I 

realized I am an intensely 

focused person, which isn’t all 

that surprising. I’m rarely prone 

to panic, but I’m also not very 

calm. The device and watch app 

vibrated gently to remind me to 

take deep breaths when I was in 

the midst of a long stretch of 

focus. Guided meditative boosts, 

SPIRE’S HOME SCREEN shows your breath in real-time.
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which are accessible in a different part of the app and range in length 

and topic, were calming, reminding me to release tension from my head 

and shoulders and take intentional breaths. It was like a yoga class 

without any movement.

BOTTOM LINE

I have a few issues with Spire. It takes 

forever to sync data from the device to 

your iPhone if you don’t let the Spire 

app run continuously in the background. 

(I’m not a big fan of keeping location-

tracking apps open to keep my battery 

alive as long as possible.) But the device 

only stores six hours of information 

locally before it’s lost, so if you forget to 

sync the two, your data disappears.

I also wish Spire were a more useful 

activity tracker. It tracks your steps, 

active minutes, and calories burned, but 

it has no clue what kind of exercise 

you’re doing. You have to manually add 

a note to each burst of activity. The 

device also doesn’t track sleep, though 

Spire cofounder and chief scientist 

Neema Morajevi told me that’s in the 

works.

It’s also tough to tell if mindful breath-

ing does anything to reduce your stress 

long-term. Taking control of your breath, 

which is just one indicator of stress, 

might not do anything at all to improve 

your overall mental well-being, though it 

might feel like it in the moment.

I do love Spire’s design (which picked 

up a Cooper Hewitt National Design 

Award in 2014). Even the charging puck 

that comes with the device is Apple-

SPIRE’S NOTIFICATIONS NUDGE 

you to focus on your mind, 

not just your step count.
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esque. And I appreciate that it can survive a trip through the washing 

machine if you forget to take it off before throwing your clothes in the 

hamper. But Spire is $130 (down from $150 when it was released), which 

is a little expensive for a device with no display. That money could go 

toward a great fitness tracker. And if you already own an Apple Watch, 

the release of watchOS 3 this fall puts Apple’s Breathe app on your 

wrist. It won’t track your breathing the way Spire does, but it will remind 

you to take time to focus on your mental health, which is Spire’s end 

goal. ■
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SPIRE IS BEAUTIFULLY 

designed, and so is its 

charging puck.
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Homer
Read With Homer (freemium, go.

macworld.com/readwhomer) has 

been updated with back-to-school-

themed content about dinosaurs, 

giraffes, and presidential pets. As ever, the app 

features more than 1,000 phonics lessons to 

help kids ages two through eight learn to read.

Aceable Drivers
Your iOS device is full of tricks—it can 

even teach you to drive. Aceable 

Drivers (freemium, go.mac world.com/

aceable) lets you fulfill the classroom 

portion of driver’s ed training—using memes, 

animation, and voice-overs—in Texas, California, 

Florida, Illinois, or Ohio. If the lesson doesn’t quite 

take, Defensive Driving (freemium go.mac world.

com/defdriving) lets you take the remedial class you 

need to clear away a traffic ticket from your record. 

Timelines
Timelines ($5, iPhone only, go.

macworld.com/timelinesapp) helps 

you track the time spent on certain 

tasks—useful for lawyers, freelancers, 

or “simply someone who wants to understand 

and improve her time efficiency.” You can even 

export the information as a PDF or spreadsheet.

SampleTank
SampleTank ($20, iPhone only, 

go.macworld.com/sampletank) has 

long let you augment your band with 

an endless variety of musical sounds. 

Now IK Multimedia—the creator of a number of 

top-shelf iOS apps and accessories for musi-

cians—has launched Version 2.0, which includes 

an interface redesign, more than 1,900 available 

sounds, and an “inspiring” new Sound Browser.

What’s  
new at the  
App Store

TEENAGE MUTANT  
NINJA TURTLES
Teenage Mutant Ninja Turtles ($4, 

go.macworld.com/tmntapp) isn’t 

just another movie-based video 

game. It’s filled with STEM con-

cepts to help your child learn 

problem-solving techniques and 

skills that will serve them well in 

the classroom and the real world. 

Cowabunga!
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STEM stuff!
This month's roundup of iOS accessories includes a kit that helps 
your kids master the basics of engineering, science, and math—
and, oh yeah, it’s fun to boot.  

88
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ZMODO
The Torch Pro ($199 MSRP, zmodo.com, $198.67 on 

Amazon) is a camera system that connects your 

doorbell to your iPhone—the system lets you 

answer your door directly from your smartphone, 

allowing you to “see, hear, and speak to your 

visitors, even if you’re not at home.”

OMNICHARGER
Omnicharge Portable Power Bank ($129 MSRP, omnicharge.co) 

is a mind-boggling 20,400-mAh power bank with two USB ports 

for your iOS devices and an AC/DC outlet to power up your 

MacBook. It’s apparently popular—with more than a week left in 

its crowdsourcing stage, the makers’ production goal of 

$50,000 has already been exceeded by a factor of 10.

iOS CENTRAL
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HEREONE
Here One ($299 MSRP hereplus.me) is a 

“truly wireless listening system” containing 

two earbuds—you’ll also have to download a 

compatible app—that lets you “stream music, 

take phone calls, reduce unwanted noise, 

amplify speech, access Siri and Google Now, 

and more.” Here One is available for preor-

der now, and is scheduled to ship by the 

holiday season.

LITTLEBITS
The Rule Your Room Kit ($99.95 MSRP, 

littlebits.cc) is for your innovation-obsessed 

kids—it’s a box of electronic doodads they 

can use to build eight different inventions, 

letting them have fun and helping them 

build engineering, science, art, and math 

skills along the way. The LittleBits Invent 

app on your iPhone helps guide the 

invention process.



BOSE
You know all those apps that 

help your kid learn to code? 

BoseBuild ($149 MSRP, 

buildbose.com) is the 

real-world version of that—

it’s a high-performance 

Bluetooth speaker designed 

to be built by children, 

teaching them lessons about 

magnets, sound, and more.

ZERAPH
The Flo ($40 MSRP, zeraph.co) is 

a “contact-free” thermometer—

place the device about an inch 

away from the patient’s head to 

get an accurate reading within a 

second. (You can also check milk 

or water temperature using the 

device.) Use the app to make 

profiles for family members and 

track their temperature over time.

iOS CENTRAL

STEM stuff!
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For more safety tips visit SmokeyBear.com



iPHONE 7  
HANDS-ON: 

FEATURE    

PERFECTLY ADEQUATE, 
STILL UNDERWHELMING

PHOTOGRAPHERS  

GET A BETTER  

CAMERA, AND THE  

ACCIDENT-PRONE  

GET WATER RESISTANCE.  

WHAT ABOUT  

EVERYONE ELSE?  

BY SUSIE OCHS
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T
he iPhone we’ve been 

hearing rumors about 

for months (go.mac-

world.com/iphone7ru-

mors) is finally real, so 

let the anguish over its confirmed 

lack of a headphone jack begin. 

(Since this might have been the 

worst-kept secret in Apple history, 

hopefully you’ve worked through a 

few stages of grief already.)

It’s true. Apple used the space 

freed up by removing the head-

phone port to add a Taptic Engine 

under the hood, as well as a sec-

ond speaker to the bottom of the 

device. The company says this will 

give you stereo sound, and the 

speakers did sound louder, but the 

busy demo area was just too 

crowded and noisy to properly 

evaluate how much of a difference 

the second speaker makes. In fact, 

during my limited hands-on time 

after Apple’s September 7 event, I 

found the iPhone 7 ho-hum—it’s 

faster and it’s got a better camera, 

but a lot of the changes (the new 

Home button, the dual speakers) 

are too subtle to make much of a 

first impression.
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CHANGES TO THE 
HOME BUTTON
About that Taptic Engine, for exam-

ple—it’s there to enable a completely 

flush, motionless Home button. One of 

the rumors about 2017’s iPhone is that 

Apple may ditch the Home button, 

embedding it in the screen instead. For 

the iPhone 7, Apple kept the “chin” at 

the bottom of the device, with the 

Home button and its shiny Touch ID 

ring in their familiar place. But the 

button no longer physically moves up 

and down. Instead, you press it and get 

a little vibration of haptic feedback so it 

feels like it’s going down.

This is similar to the Force Touch 

trackpad in the 12-inch MacBook, 

which doesn’t physically click but still 

mimics what a click should feel like. 

As on the Mac side, iOS developers 

will get access to the Taptic Engine 

for building more subtle vibration 

effects into their apps, reacting to 

your touch. In my hands-on time at 

the event, the new Home button felt 

pretty odd to click, with a split-sec-

ond lag before I felt anything. Two of 

Apple’s demonstrators mentioned 

that it takes a little adjustment before 

it feels normal. Luckily, there’s a 

setting where you can customize the 

haptic feedback somewhat.

Physically, the iPhone 7 and 7 Plus 

are the same size as their predeces-

sors, the iPhone 6s and 6s Plus. But 

don’t expect any iPhone 6 or iPhone 

6s cases to fit an iPhone 7, because 

the camera lens on the back is a lot 

bigger than it used to be, and so is 

the TrueTone flash. Similarly, iPhone 

6 Plus and 6s Plus cases almost 

definitely wouldn’t fit an iPhone 7 

Plus, since that device has a dual-

camera setup I’ll explain a bit later. 

New cases all around.

FEATURE     i PHO N E 7 H A N DS- O N

THE HOME BUTTON sits 

flush with the case. 



If you can stomach slapping a case 

on your new phone in the first place, 

that is. The iPhone 7 comes in silver, 

gold, and rose gold finishes, but the 

“space gray” color has been 

replaced by not one but two versions 

of black. The matte version is just 

called black, and it’s lovely, with an 

almost brushed aluminum effect that 

does pick up fingerprints, but more 

on its shiny black Apple logo than on 

the rest of the device. The highly 

glossy “jet black” version has a 

shinier finish, like a grand piano, and 

it’s a magnet for fingerprints—and 

maybe tiny scratches too. Apple 

even has a disclaimer on the iPhone 

7 pre-order page: “Its surface is 

equally as hard as other anodized 

Apple products; however, its high 

shine may show fine micro-abrasions 

with use.” The company suggests 

you use a case if you’re concerned, 

but then no one can appreciate your 

glossy phone. It’s subjective, but I 

like the matte version better anyway.

NEW CAMERAS AND 
WATER RESISTANCE
Like the iPhone 6s’s, the iPhone 7’s 

camera bulges out from the back of 

the phone, but the bulge rises 

directly out of the iPhone’s rear 

panel. In the iPhone 6s, the camera 

bulge has an aluminum ring around it 

that makes it look kind of stuck on 

after the fact, while the iPhone 7 

camera bump looks a little more like 

it belongs. I prefer the iPhone SE’s 

design in which the camera is 

completely flush, but it’s not a 

deal-breaker.

The 7 Plus has a dual-lens setup: 

THE CAMERA and 

flash are a lot 

bigger, so 6s 

cases won’t fit. 
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two 12-megapixel cameras side by 

side on the back. One is the same 

wide angle as in the iPhone 7, and 

the second is a telephoto lens. 

Tapping the 1x button above the shut-

ter in the Camera app switches to the 

2x view of the telephoto lens 

instantly—it’s so fast it’s like you’re 

using the same camera, not switch-

ing between two. Holding the button 

down lets you push past the 2x 

optical zoom, up to 10x of digital 

zoom (in photos; 5.8x when shooting 

video), although digital zoom 

enlarges the pixels and thus 

degrades the image quality. The 

Portrait mode with its bokeh effect 

demonstrated on stage won’t be 

ready until a software update later in 

the year, for iPhone 7 Plus owners 

only. None of the demo units in the 

hands-on area had it yet.

The iPhone 7 and 7 Plus have 25 

percent brighter screens with a wider 

color gamut, although the sizes and 

pixel dimensions remain the same. 

Every iPhone screen looks great to 

me, and these were no exception. 

But the difference wasn’t so notice-

able that it would sway me to 

upgrade just for the extra brightness. 

Maybe when we get to test the 

phones outdoors, we’ll see a bigger 

difference.

Ready for one more thing? This is 

the first officially water resistant 

iPhone! Last year’s iPhone 6s had 

FEATURE     i PHO N E 7 H A N DS- O N

THE IPHONE 7 camera 

bumps out of the 

aluminum around it. 

TWO CAMERAS on the 

iPhone 7 Plus. 
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some under-the-hood water resis-

tance (go.macworld.com/iphone-

6sh2oproof), but Apple didn’t adver-

tise it. Instead of shoving ugly rubber 

plugs into the various ports to keep 

liquid out, the company added 

gaskets inside the case and water-

proofed individual connections 

between internal cables and the logic 

board. Think of that as a beta test of 

sorts, because now Apple is proudly 

calling the iPhone 7 splash, dust, and 

water resistant, with a rating of IP67 

(go.macworld.com/ipcode). That 

means it should withstand powerful 

streams of water right on it, as well as 

dunks in up to a meter of water for 

30 minutes. Unfortunately, Apple 

didn’t provide a dunk tank in the 

demo area, so that’s another thing 

we’ll have to test for the full review.

BOTTOM LINE
So, Apple giveth us water resistance 

and a more powerful camera, even 

as it taketh away our faithful friend 

the 3.5mm headphone jack. The 

iPhone lineup still lacks built-in 
THE MATTE BLACK color is lovely, and there’s a 

glossy “jet black” option too. 

THE IPHONE 7 PLUS 

dual lens switches to 

the 2x view of the 

telephoto lens 

instantly. See it action 

at go.macworld.com/

vineiphone7zoom.
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wireless charging, Apple Pencil 

support, and an OLED screen, but 

the iPhone 7 is no slouch. (Apple 

bragged that the 64-bit A10 Fusion 

chip makes this the most powerful 

iPhone in history, but that’s a pro-

gression that we expect—obviously 

Apple wouldn’t want the new phone 

to be slower than the older models.)

Photographers and the accident-

prone have the most reasons to 

rejoice, but personally, I’m not 

excited enough about the new 

cameras or the waterproofing to 

preorder a new iPhone for launch. As 

much as I like the AirPods (which 

won’t be ready for the iPhone 7’s 

launch), the inconvenience of plug-

ging headphones into the Lightning 

port until then is keeping me in 

wait-and-see territory, until I find out if 

the brighter screen and the better 

camera are really enough to make 

me screw up my “courage” and bid 

the headphone jack a permanent 

goodbye. ■

FEATURE     i PHO N E 7 H A N DS- O N

Macworld Recap: Apple 2016 Event

VIDEO

To view this video, 
go to go.

macworld.com/
ae916recap
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The “It’s Only Another Beer” 
Black and Tan

8 oz. pilsner lager

8 oz. stout lager

1 frosty mug

1 icy road

1 pick-up truck

1 10-hour day

1 tired worker

A few rounds with the guys

Mix ingredients.

Add 1 totalled vehicle.

Never underestimate ‘just a few.’

Buzzed driving is drunk driving.



APPLE WATCH SERIES 2 HANDS-ON: 

Ceramic is stunning, but 
Hermès overpriced
By Susie Ochs

IMAGE COURTESY OF APPLE
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I
t’s really hard to tell the difference between the new 

Apple Watch Series 2 (apple.com/apple-watch-series-2) 

models and the originals—the aluminum and steel 

versions anyway—until you place them side by side. 

Turns out, the Series 2 models (top) are ever so slightly 

thicker than their predecessors (bottom). Just a hair, not 

enough to even complain about, really, and it’s certainly not a 

deal-breaker. But from Apple, a company with a track record 

of sacrificing ports and redesigning keyboards in order to 

make its products thinner and thinner and thinner, the Apple 

Watch’s extra bulk is a sign that the company is still adding 

hardware features to find the best mix. In this case, GPS.

FEATURE     A PPLE WATCH SER I ES 2 :  H A N DS- O N
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What remains to be seen—and 

isn’t a one-size-fits-all answer any-

how—is whether GPS will be worth 

the extra cost for the Series 2. After 

all, GPS and 50m waterproofing are 

the only differences between the 

Series 2 watches and the Series 1, 

which is still on sale. Aluminum 

Series 1 models, formerly called 

Apple Watch Sport, are $269 for 

38mm and $299 for 42mm, and 

those Series 1 watches even have 

the same S2 chips that Apple put in 

the aluminum Series 2 models, which 

are $100 more. (Series 2 watches 

also come in stainless steel starting 

at $549, but Apple isn’t selling steel 

Series 1.) Since my hands-on time 

after Apple’s September 7 event 

didn’t include a chance to swim laps 

or go for a run, the Series 2’s exclu-

sive features didn’t have the oppor-

tunity to impress me—yet.

Still, one Series 2 watch called out 

to me from the crowded table of 

demo units: the ceramic model. 

THE CERAMIC APPLE 

Watch Edition caught 

me by surprise with 

its glossy white shine. 
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Shiny and pristinely white, it looks 

like it was carved from a solid block 

of unicorn horn. I’m a little surprised 

it only comes in white (colors next 

time, maybe?), but it’s a pleasant 

throwback to when Apple offered a 

whole range of glossy white prod-

ucts, from iPods to MacBooks.

The ceramic Apple Watch Edition 

(apple.com/apple-watch-edition), 

which Apple says is four times harder 

than stainless steel, was the biggest 

surprise in Apple’s keynote, both for 

what it is and what it isn’t: gold. While 

it starts at a jaw-dropping $1,249 for 

the 38mm version, the ceramic Apple 

Watch Edition replaces the solid-gold 

Apple Watch Edition models that cost 
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EVEN THE BACK of the 

ceramic watch is 

pretty. 
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$10,000 to $17,000 when they 

launched in the spring of 2015. 

Funnily enough, that gorgeous 

ceramic watch is only sold with an 

off-white (sorry, “Cloud”) Sport Band, 

a $49 strap that matches the look 

perfectly but didn’t seem luxe 

enough to me considering the 

four-figure package price.

The Apple Watch Hermès (apple.

com/apple-watch-hermes) models, 

on the other hand, have the opposite 

problem. For $1,149 and up, you get a 

stainless steel Apple Watch Series 2 

with exclusive Hermès watch faces 

and a high-end leather band. I tried 

on the 38mm size with an Etoupe 

Swift Leather Double Buckle Cuff, 

which felt like butter even if it did 

take twice as long to put on as a 

I DID LIKE the Etoupe 

Swift Leather Double 

Buckle Cuff, but you 

can get it on its own for 

less than the ridiculous 

Hermès Edition 

upcharge. 
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watch with, well, a single buckle. But 

it retails for $1,499, and that math 

doesn’t come close to adding up: A 

stainless steel Series 2 watch with a 

Sport Band is $549, which means 

that stepping up to the Hermès is 

paying $950 more to get the fancier 

cuff and the Hermès watch faces. 

Well, looky here, the exact same cuff 

can be had on its own for $689 (go.

macworld.com/hermesstrap)

That just leaves the faces, based 

on classic Hermès watches called 

Clipper, Cape Cod, and 

Espace—but honestly, I 

don’t think they’re 

good-looking. I wouldn’t 

pay $5 for one in the 

App Store even if I 

could.

Finally, the Apple 

Watch Nike Plus (apple.

com/apple-watch-nike) 

is an aluminum Apple 

Watch Series 2 in space 

gray or silver, with a 

special Nike Sport Band 

and exclusive Nike 

watch face. The bands 

are vented all the way 

around and stand out 

thanks to Nike’s eye-

catching neon-yellow 

Volt color. (Plainer black/

gray and silver/white 

colorways are available 

too, but if you’re gonna 

go Nike, go neon, I say.)

Aimed at runners, the Nike watch 

face will even nudge you to pound 

the pavement more often, by remind-

ing you how long it’s been since you 

last ran, how nice the weather is, or 

how hard your friends are smoking 

you on the leaderboards. Keeping in 

mind that any Apple Watch running 

watchOS 3 will let you share Activity 

rings for a little friendly competition, 

but Nike’s implementation seems like 

a lot of fun. And the prices are the 
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THE HERMÈS FACES just 

don’t do it for me. 
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same as the rest of the aluminum 

Series 2 models, so whether you go 

Nike or not is simply a personal 

preference.

Bottom line
I’m eager to test the GPS and lap-

counting Swim workouts in the new 

Apple Watch Series 2, once they 

ship, and see how long the battery 

lasts compared to my trusty first-gen 

Apple Watch. Until then, I think the 

ceramic watch is the best looking if 

you’re willing to shell out for it, the 

Hermès Edition isn’t worth the money 

(but the à la carte bands might be), 

and the aluminum Series 2 watches 

continue to be a pretty good deal.

If you already have an Apple 

Watch, there’s no need to upgrade, 

but if you’ve been waiting to jump on 

board, now’s a great time, and if you 

don’t mind forgoing GPS, the Series 1 

option saves you money without 

sacrificing speed. Apple started 

taking preorders September 9, and 

shipping the watches September 16. 

(Hermès models shipped September 

23, and Nike models in late October.) 

New bands (go.macworld.com/watch 

bands) are in the Apple Store. ■

APPLE WATCH NIKE PLUS, neon yellow optional. 
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  AMERICA,

 LET’S DO LUNCH TM
Julius Gaines, SINCE 1933. He’s got a curious intellect that can’t be satiated. 

Now, he and 1 in 6 seniors face the threat of hunger and millions more  

live in isolation. So pop by, drop off a hot meal and say a warm hello.  

Volunteer for Meals on Wheels at AmericaLetsDoLunch.org



WORKING MAC Tips, Tricks, and Tools to Make You 
and Your Mac More Productive

How to use Optimized Storage  
in macOS Sierra
This new feature in Apple’s latest Mac operating system promises to free 
up precious storage space.

BY ROMAN LOYOLA
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Optimized Storage requires iCloud, 

Apple’s online service. Apple pro-

vides 5GB of free iCloud Drive 

storage per Apple ID, so you may 

want more to take full advantage of 

Optimized Storage. iCloud storage 

pricing as follows: 5GB for free; 

50GB for $1 per month; 200GB for 

$3 per month; 1TB for $10 per month. 

Apple has instructions (go.macworld.

com/icloudstorageupgd) on how to 

buy more iCloud storage.

To access the Optimized Storage 

options in macOS Sierra:

1. Go to Apple menu → About This 

Mac.

2. In the window that appears, click 

on the Storage tab, then click Manage.

This bar graph has changed a bit 

from the one in OS X El Capitan, 

which provided a color-coded key 

below the bar to tell you how your 

storage is being allocated. In Sierra, 

the color-coded key is gone, but if 

you move your cursor over the 

colored sections, you can see what 

each section represents. For exam-

ple, the light blue section next to the 

yellow System section in the screen-

shot below is for Other Users.

If you look closely at the screen-

shot below, you can see a small 

white-with-gray-stripes section. This 

is what Apple calls Purgeable, and it 

WORKINGMAC HOW TO USE OPTIMIZED STORAGE

A
pple’s laptops rely on flash storage, and prices really 
shoot up if you want more local storage (the actual 
storage in your computer)—if the model you want 
offers an upgrade in the first place. The new Opti-

mized Storage feature in macOS Sierra (go.macworld.com/
macos-sierra) is designed to help free up precious storage space 
on your Mac.
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indicates that these 

are really old files that 

you can probably 

archive, save to the 

cloud, or delete in 

order to free up 

storage space.

To the right is the 

main interface for 

Optimized Storage. 

First, let’s go over the 

choices in the Recom-

mendations window 

that appears in the 

main section. Then 

let’s look at the 

options in the left column.

OPTION 1: STORE IN iCLOUD

This option houses your most 

recently used files and optimized 

photos in local storage. Here’s why 

you might want to upgrade iCloud: 

Your iCloud Drive is used as long-

term storage for your original files 

and full-resolution photos and videos, 

which can be downloaded to your 

Mac when you need them.

You are able to fine-tune this 

option a little. When you click on the 

MAIN WINDOW for 

Optimized Storage.

FINE-TUNING 

the Store In 

iCloud option.
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Store In iCloud button, you have the 

choice to save files from the Desktop 

and Documents folders (go.mac-

world.com/iclouddesktopdocs) in 

iCloud. You can also 

enable/disable the 

ability to store photos 

and videos in iCloud 

Photo Library.

If you want to modify 

the Store in iCloud 

options after you have 

turned it on, you have 

to go to the iCloud 

system preferences for 

Desktop and Docu-

ments, and the Photos 

app preferences for 

iCloud Photo Library.

OPTION 2: OPTIMIZE 

STORAGE

Video files take up a lot of space. If 

you like to watch TV shows and 

AUTOMATICALLY 

REMOVE iTunes TV 

shows and movies 

you’ve already 

watched.

MODIFY THE Optimize 

Storage settings in 

iTunes’ preferences.
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movies from iTunes, you may not 

realize that the videos you have 

already watched are just sitting on 

your Mac. Optimized Storage auto-

matically removes these files for you. 

You can download them from iTunes 

again whenever you want.

If you turned this on and decide 

later that you want to turn it off, you 

do so in iTunes (iTunes → Preferences 

→ Advanced).

Optimized Storage also works with 

email attachments. These files are 

automatically removed from your 

Mac. The idea here is that since the 

email attachment is being stored on 

an email server, there’s no need to 

keep it on your Mac. You can simply 

get the attachment from the server 

again, though if you’ve deleted the 

email completely, the attachment is 

gone, too.

To use Optimized Storage with 

email attachments, you must use 

Apple’s Mail app. You can use any of 

the popular email services, like 

Gmail, Yahoo, and Outlook.

OPTION 3: EMPTY TRASH 

AUTOMATICALLY

What’s cool about this option is that 

it’s basically like the Recently Deleted 

folder of iOS’s Photos app. Items stay 

in the Trash for 30 days; once the 30 

days are up, the item is deleted.

Unlike the iOS Photos app’s 

Recently Deleted folder, the files in 

the Mac’s Trash aren’t labeled with 

how many days are remaining before 

deletion. To get this information, you 

ERASE TRASH 

AUTOMATICALLY 

deletes files that 

have been in your 

Trash for 30 days.
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have to go into the Optimize Storage 

interface (Apple menu → About This 

Mac → Storage → Details), and then 

click on the Trash listing in the left 

column. You’ll see a list of files in the 

Trash, with a date when the file was 

last accessed.

If you decide to turn this feature 

off, you will notice that there’s no way 

to do so in this interface. You do it in 

the Finder preferences; in the Finder, 

select Finder → Preferences, then 

click Advanced. Uncheck the box for 

Remove Items From The Trash After 

30 Days.

OPTION 4: REDUCE CLUTTER

This is an interface you can use to sift 

through your files and figure out 

which ones to delete or move to 

another storage medium. It’s more 

efficient than opening a bunch of 

Finder windows and looking at the 

files that way. Also notice that when 

you click on the Review Files button, 

it’s the same as selecting Documents 

in the left column.

There are three different ways to 

view the files on your Mac.

> Large Files lists the files on your 

Mac from the largest to the smallest.

> Downloads shows what’s in your 

Downloads folder.

> File Browser lets you navigate 

your storage device. It’s like viewing 

SELECTING TRASH 

in the left column 

provides more 

details about the 

files in your Trash.

IF YOU DECIDE you 

want to turn off Empty 

Trash Automatically, 

you can do so in the 

Finder preferences.

WORKINGMAC HOW TO USE OPTIMIZED STORAGE
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a Finder window in List view.

> iOS Backups (not pictured). If 

you sync your iOS device to your 

Mac, iTunes keeps a few older 

backups, in case you want to restore 

to a previous point in history. These 

backups take up a lot of space, so 

you may want to delete older ones.

In Large Files and Downloads, if 

you move your cursor over a file, you 

can then click on the X button to 

delete the file, or click the magnifying 

glass to see the file in the Finder. In 

the File Browser, you need to right-

click a file to move it to the Trash.

WHAT’S IN THE LEFT COLUMN 

OF THE WINDOW

The items that appear in the left 

column vary. What appears depends 

on how you use your Mac. For 

example, if you use Mail, then you’ll 

see an entry for Mail. If you use 

GarageBand, there will be an entry 

for GarageBand.

As of the macOS Sierra Public 

Beta 4, there is an Applications 

option in the left column. This 

provides a view of all the applica-

tions on your computer, and lists 

them by size. When you place a 

cursor over an app, you get the 

Delete and Show In Finder icons, 

like the ones that appear in Docu-

ments. But the Delete function didn’t 

work for me. I tried to delete several 

apps this way, and the apps were 

still there, even after I restarted the 

computer. So it’s unclear if this 

delete method also removes all of 

REDUCE CLUTTER is the 

same as selecting 

Documents in the left 

column.
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the files the apps install during the 

installation, a longtime pet peeve 

(go.macworld.com/uninstallma-

capps).

Also, this view doesn’t show every 

application on your Mac. None of the 

Apple apps that come with Sierra are 

shown here, though App Store apps 

do appear. Mostly, this view is for 

apps you’ve installed on your own 

from the internet or from external 

media. This leads me to the usual 

disclaimer…

UPDATES ARE COMING

This look at Optimized Storage was 

done using the macOS Sierra Public 

Beta. It will be updated as OS 

updates become available and when 

Apple officially releases macOS 

Sierra. ■

APPLICATIONS 

CAN BE deleted 

through 

Optimized 

Storage.

WORKINGMAC HOW TO USE OPTIMIZED STORAGE
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End the clutter: How to organize 
your Mac menu bar
The Mac’s menu bar is a handy place for quick access to apps and system preferences. 
But it can easily be a crowded space.

BY JEFFERY BATTERSBY
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WORKINGMAC END THE CLUTTER

It’s not just OS X that puts menu 

extras at the top of your display; 

third-party apps do as well. Some 

offer similar features, such as access 

to oft-used functions, and others can 

provide status information.

But all this comes at a price: clutter.

If you have a Mac with a large 

display, then you probably don’t 

worry about how many icons are in 

your menu bar, though they can give 

you sensory overload. But if you 

have a laptop, you may find that not 

all of your menu-bar extras display 

when an application you run has a lot 

of menus of its own. App menus get 

priority, and if you’re working with an 

app with lots of menus, some of your 

menu-bar extras simply disappear.

Here’s what’s in my menu bar, from 

left to right: Dropbox, Airfoil Satellite, 

TypeIt4Me, BusyCal, BitTorrent Sync, 

HazeOver, Moom, f.lux, Evernote, 

Plex, then a group of status menu-

bar extras from iStat Menus. Next 

come system menu-bar extras: 

Messages, Wi-Fi, Eject, Time 

Machine, Volume, Bluetooth, Input, 

User, Spotlight, Notification Center.

That’s a lot of stuff.

CHANGING POSITIONS

Menu-bar extras are in two groups: 

third-party items at the left, system 

items at the right. You can change 

the position of any third-party 

menu-bar extra by pressing the 

Command key, clicking it, and 

dragging it to a new location. (And 

you’ll be able to do this with third-

party extras in macOS Sierra.)

REMOVING MENU-BAR 

EXTRAS

For system items, just press Com-

mand and drag a menu-bar extra 

away from the menu bar to remove it. 

For third-party items, you’ll need to 

Y
our Mac’s menu bar is a useful tool. It displays “menu-
bar extras,” little icons that give you status information 
about your Mac, or that offer quick-access menus to 
certain settings. For example, you can click the Wi-Fi 

icon to turn Wi-Fi on or off, or to select a Wi-Fi network. You can 
click the User icon to go to the login window, or to select a differ-
ent user and switch to their account. Or you can click the key-
board icon to change input methods, if you work with different 
keyboard layouts.

HERE’S THE menu bar 

on my 27-inch iMac.
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check the apps that 

added the menu-bar 

extras. Many of them 

can be removed, usually 

from a checkbox in the 

preferences or settings. 

However, some apps 

don’t let you do this; 

there would be no other 

way of accessing 

settings or features. For 

example, while Dropbox 

offers access to settings 

from its app, there’s no 

way to pause or resume 

sync, or to see what’s syncing 

without the menu-bar extra.

The $15 Bartender (go.macworld.

com/mbt) can solve this problem. It 

allows you to reorganize all your 

menu-bar extras, creating a second 

bar that only displays on demand. 

You can also rearrange all the 

menu-bar extras with Bartender, 

whether they’re part of OS X or come 

from third-party apps.

ADDING MENU-BAR EXTRAS

For third-party menu-bar extras, as I 

said earlier, each app has a setting, 

and you may add or remove some of 

these. To add system items, you 

need to go into System Preferences. 

For example, the Wi-Fi menu-bar 

extra setting is in the Network pane; 

the User extra setting is in Users & 

Groups; the Volume setting is in 

Sound; and so on.

There are some other menu-bar 

extras you can add, but only if you 

know where they’re hiding. If you go to 

/System/Library/CoreServices/ 

Menu Extras you’ll find two dozen 

items you can add to your menu bar. 

Double-click any of these to add them 

to your menu bar.

Some of these are available from 

System Preferences, but not all. For 

example, I use the Eject menu extra 

to be able to eject discs from my 

optical drive; and if you like to use 

AppleScripts, you may want to add 

the Scripts menu extra.

Menu-bar extras are useful, but only if 

you don’t get overwhelmed. Taking 

control of your menu bar can make you 

more efficient, and save you time. ■

A HARD-TO-FIND 

folder contains a 

number of useful 

menu extras.
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Hands on with macOS Sierra’s 
Console: Now it’s easier to get 
the Mac information you need
Improvements make the Console less intimidating to use.

BY KIRK McELHEARN

WORKINGMAC
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WORKINGMAC HANDS ON WITH macOS SIERRA’S CONSOLE

In the current Console, log entries 

show up as long lines of text. The 

names of processes and applications 

are bolded, but that’s about it. In 

Sierra, Console gets a whole new 

display. As you can see on the next 

page, there are now columns that 

make it easier to view and sort 

messages.

There are four columns by default, 

and if you right-click on a column 

header, you can choose others. The 

default columns are Type, Time, 

Process, and Message, but you can 

add others, such as Library, PID, 

Thread ID, and more. Most of these 

are only of interest to developers, 

but users will find it easier to trouble-

shoot when they can more easily 

view additional information.

I
f you’ve ever looked at the Console app in OS X, you’ve 
seen how frustrating it can be to glean any useful information 
from its overladen logs. Console displays log information that 
can help you troubleshoot problems (go.macworld.com/

consolelog) on your Mac, but it also records a plethora of status 
messages. Wading through a never-ending stream of messages 
in Console has always been difficult, but Apple has reworked 
Console in macOS Sierra, making it a lot more usable. Here’s a 
brief overview of what’s new.

THE OS X CONSOLE’S 

display is daunting.
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Another change is the ability to 

pause the display by clicking the 

Now button in the toolbar. Click that 

and the river of messages freezes, so 

you can see what’s happening in the 

moment. And when you click on a log 

entry to view it, a new Info Pane 

below the entry list gives you more 

information, and lets you focus on a 

single entry even if you haven’t 

paused the display.

Console displays both status 

messages and error messages, and 

an option above the message list lets 

you choose to view all messages, or 

just errors and faults. It’s these latter 

that you are more often interested in, 

and this is a boon for troubleshooting 

problems.

The Errors And Faults option is 

actually just a saved search. Another 

new feature in this version of Con-

sole is an improved search feature. 

Type a search term in the Search 

field, press Return, and Console 

displays a menu next to the term. 

Click this, and you can choose from a 

number of search criteria. As with the 

columns I mentioned previously, 

these include Process, PID, Message 

Type, and more. This makes it easy 

to narrow down messages from a 

specific app or process.

And you can save these searches, 

CONSOLE in macOS 

Sierra has gotten a 

full makeover.
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as you save smart folders in the 

Finder. Click the Save button, and 

your search displays in the search 

bar above the messages. (You can 

already save search queries in El 

Capitan, but this method is easier, 

and offers more options.) If you’re a 

developer, you’ll find this saves a lot 

of time when you need to check on 

what your app is doing.

Not everyone needs the Console 

app, but those who work with it will 

find these improvements make their 

work a lot easier. ■

WORKINGMAC HANDS ON WITH macOS SIERRA’S CONSOLE

THE NEW CONSOLE 

app lets you create 

targeted searches.
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How to use dictation on your Mac
Instead of pointing, clicking, and typing, you can use your voice for input on your Mac.

BY JEFFERY BATTERSBY
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WORKINGMAC HOW TO USE DICTATION ON YOUR MAC

I CAN HEAR  

YOU NOW

You may think you 

have to wait for Siri 

to appear in macOS 

Sierra before you 

can talk to your 

Mac, but your Mac 

already has a way 

to listen to every-

thing you say and to 

turn what it hears 

into text. You can 

enable this feature, 

which supports over 

30 languages and 

many more dialects, 

using the Dictation 

& Speech prefer-

ence in System 

Preferences.

Apple’s speech-

to-text features are 

turned off by 

default, so before 

you can use this feature you need to 

turn it on.

1. Open System Preferences.

2. Click Dictation & Speech, which 

you’ll find in the middle of System 

Preferences’ fourth row.

3. Click the radio button that says 

On. You will see a message warning 

you that using your Mac’s dictation 

option the way it’s currently set up 

will send your spoken text to Apple 

to be converted.

T
his month, I am in a place where I can’t work directly 
with my servers to test the NetInstall steps and images, 
so…we’ll take a brief detour and look at your Mac’s 
built-in dictation features.
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4. Click Enable Dictation. 

The default keyboard 

shortcut to begin dictating 

is to press your Mac’s Fn 

key (function key) twice. If 

you aren’t using an Apple 

keyboard with such a key, 

choose a different shortcut key.

Let’s give this a test:

1. Open the TextEdit app.

2. Select File → New to create a 

new document.

3. Press the Fn key (or your 

selected shortcut key) twice and 

begin speaking to your Mac.

Note that what you say will almost 

immediately begin to appear on your 

screen. You should also note that your 

normal speech doesn’t make for very 

good text, because your normal speech 

doesn’t usually include punctuation. So, 

let’s work out a little “speech-to-text.”

LEARNING TO SPEAK AGAIN

Instead of your normal speech, speak 

the following text exactly as it’s written, 

but first, press the Fn key twice:

This is great

Exclamation point

I�m using Apple�s speech to 

text feature

Period

New paragraph

Pretty great

Comma

Isn�t it

Question mark

When you’re done, press the Fn key.

As you can see, this isn’t exactly 

pretty sounding speech, but, as you 

can also see, what you said is exactly 

what appears on the page. And that’s 

pretty great!

SO, ABOUT THAT WARNING

By default, Apple’s dictation feature 

uses Apple’s servers to convert your 

speech to text. This can be a prob-

lem, because whatever you’re saying 

gets sent across the Internet, con-

verted to text, and sent back to you; 

and if you don’t have access to the 

Internet you can’t use this feature. So 

let’s remedy that:

1. Open System Preferences.

2. Click Dictation & Speech.

3. Put a check in the box that reads 

Use Enhanced Dictation.

Your Mac will download the 

speech-to-text translation files to your 

Mac’s hard drive. As soon as the 

download is complete you’ll have 

access to the dictation feature without 

an Internet connection and you don’t 

have to worry about your romantic 

love poetry traveling to infinity and 

beyond to get turned into text. ■
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CREATE Using the Web for Video, Graphics, Publishing, 
Photography, and Other Creative Pursuits

10 ways to make 
your outdoor 
photos amazing
Tips and tricks for capturing great shots with 
your iPhone camera.

BY LESA SNIDER
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MAKE YOUR OUTDOOR PHOTOS AMAZING

Your iPhone is the camera you always 

have in your hand, but sometimes 

inspiration fails around the same old 

point-and-shoot methods.

Sure, there are plenty of ways to 

enhance your camera with special-

ized iPhone lenses or tripods, but 

you don’t really need extra hardware 

to get great shots. Just sticking with 

the built-in camera and assorted 

photo apps can give you some 

uniquely standout memories. Here 

are some hints on how to achieve 

them.

1. SHOOT IN 360-DEGREES

With the rise of 360-degree cameras 

(go.macworld.com/360cameras), 

interactive spherical shots are 

becoming increasingly popular both 

to view and to create—without 

spending hundreds of dollars on a 

dedicated camera.

To capture a 360-degree land-

scape that you can view on the 

desktop, via a mobile device, or 

through a VR viewer, just fire up your 

Camera app or one of the several 

360-degree apps available in the 

App Store. Facebook’s new 

360-degree photo feature (go.

CREATE

AN INTERACTIVE 

360-DEGREE shot 

uploaded from 

the Panorama app 

and viewed on the 

desktop in Google+.

S
potting great photo opportunities is a talent in itself, but 
knowing how to quickly harness your iPhone camera’s 
built-in features to capture the best shots is an entirely 
different skill.

macworld.com/360camfeature) 

automatically converts a conven-

tional panorama shot with the 

iPhone’s native Camera app into a 

360-degree image that viewers can 

explore directly in their Facebook 

timeline.

With Google Street View for iOS (go.

macworld.com/streetviewios), you get 

step-by-step instructions on how to 

create and post a 360-degree image, 

which you can then upload to Google 

PHOTOGRAPHS BY JACKIE DOVE
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Maps, your Facebook page, or 

Google+. Just launch the app and 

follow the prompts to fill in the required 

number of panels. The app will stitch a 

pleasing photo sphere image that you 

can manipulate with a mouse or finger.

You don’t have to stick with the 

iPhone Camera or Google’s app. DMD 

Panorama (go.macworld.com/dmd-

panorama), 360 Panorama (go.mac-

world.com/360panorama), and others 

offer detailed instructions on how to 

shoot and post 360-degree images.

2. SHOOT HORIZONTAL  

AND VERTICAL PANOS

Panoramas are an excellent way to 

capture extreme wide-angle shots with 

your iPhone. Just launch the Camera 

app and hold the phone upright in 
SHOT WITH GOOGLE Street View and viewed in Facebook or Google+ or Google 

Maps.

GOOGLE STREET VIEW, 360 Panorama, and DMD Panorama are among several apps available that facilitate 

mobile 360-degree immersive images.
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portrait orientation. When you hit the 

button, hold the phone with both 

hands and steadily move it in one 

direction, following the arrow prompt. 

Note any messages on the screen and 

beware of moving too quickly.

Try to lock the exposure at a 

medium brightness in the landscape 

where the light is optimal before you 

tap the shutter button, otherwise you 

risk combining different exposures as 

the camera app adjusts to various 

points in the scene.

Panos can be vertical too, and are 

shot the same 

easy way, except 

that you hold the 

phone in land-

scape orientation 

as you move. To 

finish shooting the 

scene, just tap the 

start button again 

or move the 

phone slightly in 

the opposite 

direction.

3. MAKE YOUR LANDSCAPES 

COMPELLING

Wide vista landscapes are a peren-

nial favorite of both photographers 

and viewers, but they are often a 

photographic challenge. Here are 

some simple composition tips to 

make your scenic image pop.

Always pick a main subject to 

focus on. A picture of a lake sur-

rounded by trees and shimmering 

water can be an awesome sight to 

behold, but all too often it fails to 

come across in a photo because the 

MAKE YOUR OUTDOOR PHOTOS AMAZINGCREATE
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camera’s lens does not take in all the 

majesty that your brain does. To 

compensate, focus on something—a 

bird, a person, a sailboat—some object 

that contrasts with the scene, gener-

ates interest, and guides the viewer’s 

eye around the tableau. Try using the 

iPhone’s built-in grid guide (Settings → 

Photos & Camera → Grid) that lets you 

apply the Rule of Thirds (en.wikipedia.

org/wiki/Rule_of_thirds) to help you 

convey the scenic beauty you’re after.

Another technique, called leading 

lines (go.macworld.com/leadlines), 

lets you use the natural landscape to 

cut a visual path through your 

composition, making the main vista 

both dynamic and easy to follow.

For gorgeous landscapes, apps PROCAMERA AND MANUAL apps allow multiple settings.
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like ProCamera (go.macworld.com/

procamera) and Manual (go.mac-

world.com/manualapp) both offer 

highly customizable and precise 

controls for ISO, shutter speed, white 

balance, focus, exposure, and more.

4. DRAMATIZE YOUR SKIES

Clouds are your photographic 

friends. Every landscape is enhanced 

by cloud formations because they 

provide unique points of interest and 

contrast. You don’t have to wait for 

bad weather to get great-looking 

clouds. Just start with a cloud pattern 

that has some potential.

Make the most of cloud patterns by 

employing the Rule of Thirds, giving 

your sky the top two-thirds of the action.

Then, tap the HDR (High Dynamic 

Range) setting on the Camera app 

screen. That lets you capture more 

detail in the shadows and highlights 

than using the default setting. Slight 

tweaks in either the mobile or desk-

top Photos app can easily enhance a 

sky after the fact too, but you can 

even take the drama a step further 

with dedicated photo apps like 

MacPhun’s Aurora HDR (aurorahdr.

com) or JixiPix’s Simply HDR (go.

macworld.com/simplyhdr) iPhone app.

That’s not to put down clear blue 

skies, not at all. While they may not 

seem inherently dramatic to look at, 

a pure, unadulterated cerulean hue, 

the kind that really brings out your 

subject, can be heart-stopping.

MAKE YOUR OUTDOOR PHOTOS AMAZINGCREATE
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5. BE AT ONE WITH WILDLIFE

If you love the great outdoors, 

photographing wildlife is just part of 

the scenery. While getting a bird to 

sit still for a pose will take some 

effort, try your luck with Canada 

geese, ducks, alligators, peacocks, 

deer, and farm animals.

You may be tempted to use your 

iPhone’s digital zoom to close in on 

feathers or fur, but you will likely be 

disappointed with the results. Instead 

of zooming in, get up as close and 

personal to your animal subject as 

possible without putting yourself in 

harm’s way, of course. (Beware of 

geese, alligators, and elk especially, 

but any animal you don’t know can 

react badly to close human proximity.)

Then, when you are at a good 

distance, circle the creature in order 

to capture a variety of angles. Use 

the camera’s burst mode so you 

don’t miss a shot. Make sure to use 

your exposure and focus lock and try 

to zone in on the animal’s eyes for 

depth and realism, if possible.

6. EXPLORE COLORS,  

SHAPES, AND PATTERNS

Phone cameras may not be the best 

choice for capturing expansive 
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landscapes, but they are hard to beat 

for exploring color and detail. Not all 

images have to be about something 

or of a specific object. The best part 

of the outdoors is the seasonal 

colors, so consider capturing nature’s 

hueful charm—beautiful foliage, 

flowers, leaf patterns or shadows—

for its own abstract sake.

Get up close to your subject and 

shoot from different angles to 

capture intriguing natural patterns. 

For darker environments, a judicious 

use of flash may come in handy.

7. USE SILHOUETTES

Silhouettes can dramatize just about 

any animate or inanimate subject, 

MAKE YOUR OUTDOOR PHOTOS AMAZINGCREATE
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and they’re super-easy to accom-

plish. To create one, just look for the 

light source and position your subject 

in front of it. You can shoot silhou-

ettes at any time of day, but the most 

dramatic time for outdoor silhouettes 

is when the sun is low in the sky, 

around sunrise or sunset (often 

referred to as the golden hour).

Most of the time, you can rely on 

the iPhone’s auto exposure for great 

silhouettes, but to make sure that 

you get the image you’re looking 

for—a blackened subject and a nicely 

exposed sky—tap on the brightest 

part of the image (the sky) and a 

silhouette will naturally form, pro-

vided the light source is behind the 

subject. If you need to darken the 

subject more, swipe down on the 

screen to further reduce exposure.

Need more help with getting the 

best silhouette-friendly exposures? Try 

shooting with an app like Camera+ (go.

macworld.com/cameraplusapp), 

which lets you separate focus and 

exposure controls.

8. BUILDINGS ARE 

LANDSCAPES TOO

You may wish you were going to some 

wild place on your summer jaunt, but 

maybe you can’t get 

away. No problem. The 

city is the great outdoors 

too, and that means 

streetscapes and side-

walks filled with people 

and buildings. Architec-

ture shots are just a 

different kind of land-

scape, and they can be 

equally challenging.

For building and street 

shots, the concept of 

leading lines will give 

you naturally dynamic 

images, while crazy 
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camera angles, contrasting colors, 

reflections, and mirrored windows 

can yield unique and fascinating 

looks. Just remember to look up, 

move around, and have fun snapping 

from different vantage points.

9. SHOOT IN THE BEST LIGHT

Timing is everything in photography. 

Time translates directly into available 

light, and light governs how your 

image will look. When shooting 

outdoors, the most unflattering light 

for just about any scene, person, or 

object is bright, mid-day, high-in-the-

sky sun. It robs subjects of color and 

depth, often bathing them in harsh 

light and deep shadows.

The best times to shoot are early 

morning or twilight—the so-called 

golden hours—just after sunrise or 

before sunset when the light is 

mellow, though mid-morning or later 

afternoon may be more realistically 

convenient. Sometimes it’s hard to 

figure out when the best shooting 

time will be. Not surprisingly, there’s 

more than one app to help out.

Rizon (go.macworld.com/rizon), for 

example, lets you dial in optimal times 

and will notify you ahead of time to get 

ready for your shot.

10. STORMY WEATHER

It’s not always possible to shoot 

when the weather is optimal. In some 

MAKE YOUR OUTDOOR PHOTOS AMAZINGCREATE
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places, a perpetual fog or constant 

rain can last for months. Does that 

mean you should retreat indoors with 

your iPhone cam? Heck no.

For the most dramatic atmosphere, 

compose your shot so that the stormy 

sky takes up a large proportion of the 

frame. Use leading lines, which draw 

the eye directly into the scene, to 

create powerful images. Moody skies 

and silhouettes also work well 

together for bad-weather drama.

Shooting through a window, car 

windshield, or from under an awning 

can produce distinctive shots. 

Darkened clouds create dramatic 

skies, while a little bit of rain can 

inspire unique and abstract composi-

tions, even an accidental rainbow.

Try shooting with the HDR option 

turned on to boost vibrance.

WHAT YOU SEE IS  

WHAT YOU GET

If you’re posting photos directly from 

your phone, feel free to do some quick 

tweaks in the Photos app. If you’re 

really ambitious about sprucing up a 

special shot, transfer images to your 

desktop for editing in Apple Photos 

and its various extensions (go.mac-

world.com/macphuncreative), or call 

on reinforcements like Pixelmator (go.

macworld.com/pixelmator35), Adobe 

Photoshop Elements (go.macworld.

com/pixelmator35), or Lightroom (go.

macworld.com/lrnew).

Starting off with a good shot is 

always optimal, but don’t be afraid to 

give a good photo a little boost. In 

the end, it’s what the viewer sees 

that counts. ■

RIZON
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Create a digital painting, complete with canvas texture.

BY LESA SNIDER

How to use Photoshop to turn a 
photo into a realistic painting
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TURN A PHOTO INTO A REALISTIC PAINTINGCREATE

USING A Smart Object 

lets you run filters 

non-destructively, 

plus you can reopen 

the filter’s settings to 

adjust them.

This technique works especially well 

on landscape shots, wherein you 

don’t have to worry about distorting 

facial features. This column teaches 

you how to use Photoshop CS6 or 

CC 2015, specifically, to create a 

fairly realistic painting complete with 

canvas texture (your author learned 

this technique from Jack Davis of 

wowcreativearts.com).

PREPARE THE PHOTO

In Photoshop, choose File → Open As 

Smart Object and navigate to the 

soon-to-be-painterly photo. If the 

photo is already open, activate the 

layer(s) and convert it into a Smart 

Object by choosing Layer → Smart 

Objects → Convert To Smart Object.

If you’re starting in Lightroom, 

select the image thumbnail and 

choose Photo → Edit In → Open As 

Smart Object In Adobe Photoshop. 

Once the image opens in Photoshop, 

take a peek at the Image → Mode 

menu and ensure it’s set to 8/Bits 

Channel.

FUN WITH FIVE FILTERS

This technique employs several 

O
ne of the most frequently asked Photoshop questions 
is how to turn a photo into a painting. Unless you’re a 
fine artist who’s skilled at digital painting, it can be a 
daunting task. Fortunately, the mortals among us can 

use a combination of Photoshop filters to get it done.

filters; however, Adobe shortened 

Photoshop’s Filter menu a few 

versions back, so you may be 

viewing an abbreviated list in your 

copy of the program. If you don’t see 

the categories mentioned here in 

your own Filter menu, you can 

access them by choosing Filter → 

Filter Gallery instead. Alternatively, 

repopulate the Filter menu by 

choosing Photoshop CC → Prefer-

ences → Plug-Ins and turning on 

Show All Filter Gallery Groups And 

Names. The benefit of this route is 

that the individual filter names show 

up in your Layers panel, instead of a 

generic entry named Filter Gallery.

The first filter in this technique 

roughs up the photo a little so the end 
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result doesn’t look unnaturally perfect. 

Choose Filter → Noise → Median, enter 

a Radius of 3 into the resulting dialog 

and then click OK.

Next, choose Filter → Stylize → Oil 

Paint and adjust the sliders in the 

Brush section to your liking (settings 

of 6.3, 10, 10, and 10 were used here). 

Leave Lighting turned off and then 

click OK. (If the Oil Paint filter is 

dimmed in your Filter menu, choose 

Photoshop → Preferences → Perfor-

mance and turn on Use Graphics 

Processor.)

Now choose Filter → Stylize → 

Emboss. Set Angle to around –130, 

Height to 3, and Amount to 100 

percent. Click OK and Photoshop 

turns the entire document gray—

don’t panic, you’ll fix that next.

In the Layers panel, double-click 

the icon to the right of the Emboss 

filter (circled in the top middle 

image on the next page). In the 

Blending Options dialog that opens 

(top right image on the next page), 

change the Mode menu to Overlay 

and click OK.
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Next, choose Filter → Artistic → 

Rough Pastels. In the Filter Gallery 

dialog that opens, enter a Stroke 

Length of 9 and a Stroke Detail of 16. 

Set the Texture menu to Canvas, and 

then set Scaling at 100, set Relief to 

2, and choose Top Right from the 

Light menu. Make sure Invert is 

turned off and click OK.

Last but not least, choose Filter → 

Texture → Texturizer. In the Filter 

Gallery dialog that opens, choose 

THIS DIALOG 

gives you a big 

preview area 

and, as you 

can see, the 

painterly effect 

is beginning to 

take shape.

TURN A PHOTO INTO A REALISTIC PAINTINGCREATE
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Canvas from the Texture menu. Set 

Scaling to 100 and Relief to 2. Here 

again, choose Top Right from the 

Light menu and make sure Invert is 

turned off and click OK. Whew!

FINE-TUNE THE RESULT

To adjust the settings for any of the 

filters you ran, double-click its name 

in the Layers panel to reopen its 

dialog; this is why it’s handy to see 

the individual filter names in the 

Layers panel.

If you’d like, you can reduce the 

painterly effect in certain parts of 

the image using the filter mask: the 

big white thumbnail in the Layers 

panel. To do that, click to activate 

the mask, activate the Brush tool, 

and set your foreground color chip 

to black (when dealing with masks, 

painting with black conceals and 

white reveals). In the Options bar, 

adjust the brush’s Opacity setting 

according to how much of the effect 

you want to hide and then brush 

across that area in the photo. This 

masking trick is especially helpful 

when you turn a portrait into a 

painting and you want to bring back 

145



some of the photo’s detail in the 

eyes and mouth area.

When you’re finished, save the 

document in Photoshop format to 

retain your layers. Here’s a close-up 

view of the final result, complete with 

the Layers panel.

Although it may be a little tough to 

see the detail in this painting in this 

screenshot, you’ll appreciate it more 

fully when you give it a whirl on your 

own photos. Be sure to experiment 

with the settings listed above to 

make this technique your own. ■

TURN A PHOTO INTO A REALISTIC PAINTINGCREATE

146



Create a short movie by mixing video, stills, and text.

BY LESA SNIDER

How to edit video in Photoshop CC
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HOW TO EDIT VIDEO IN PHOTOSHOP CCCREATE

GATHER YOUR FILES AND 

CREATE A NEW DOCUMENT

Photoshop links to video and audio 

files, so start by gathering video clips, 

stills (including your logo), and audio 

files into a project folder. Happily, 

linking results in nondestructive 

video editing—Photoshop applies 

your edits to a copy of original clips 

upon export. Use sequential file-

names to put files in the order you 

want them to play in the video.

Create a new document by 

choosing File → New. In the resulting 

dialog, choose Film & Video from the 

Preset menu. For a 1280x720 video, 

pick HDV/HDTV from the Size menu 

and then click OK. In the Timeline 

P
hotoshop CC is ideal for creating promotional video 
pieces, portfolio-based slideshows, and sellable videos 
for your photography business. Best of all, you don’t 
have to learn another program—you’ll use tools you’re 

familiar with. In this column, you’ll learn how to create a wedding 
video by mixing stills, video, and text.

panel that appears, click Create 

Video Timeline. Enlarge the Timeline 

panel’s clip thumbnails by choosing 

Panel Options from its fly-out menu 

(circled above). Click the largest 

thumbnail size in the resulting dialog 

HERE’S WHAT a video project folder might look like, 

including the master PSD you’ll create next.

YOU’LL SPEND lots of time in 

the Timeline panel (above) so 

increasing thumbnail size is 

helpful (left). This trick works in 

several Photoshop panels.

148



(circled on previous page) and then 

click OK.

ADD AND EDIT YOUR FILES

Click the filmstrip icon in the Timeline 

panel (circled above) and choose 

Add Media. Navigate to your content 

folder, select all the files, and click 

Open. Photoshop plops them into a 

folder named Video Group 1 in the 

Layers panel and they appear in a 

single video track in the Time-

line panel, where they’re 

referred to as clips. In your 

Layers panel, delete Layer 0 (the 

Background layer). Photoshop 

activates the next layer in both 

panels, which is the first item that’ll 

play in the video.

On-screen duration of any clip 

(video or still) is determined by its 

length in the Timeline panel. While 

you can’t extend a video (or audio) 

clip beyond its original length, you 

can extend other content indefi-

nitely—say, an image, text, shape, or 

adjustment layer. Point your cursor at 

the end of the first clip (a still of 

roses) and your cursor turns into a 

bracket with a double-sided arrow 

(circled in top image on the next 

page). The bracket points toward the 

clip that’ll be affected; when it’s 

facing left toward the roses, drag 

right to extend it.

Drag the vertical playhead bar 

(circled in the bottom image on the 

next page) rightward across the next 

clip to preview it. To trim it, position 

the playhead where you want the clip 

to end, point your cursor at the clip’s 

end and when the bracket faces left 

toward the clip, drag it to the play-

Active  
Content

Active Content

YOU CAN ACTIVATE 

clips in the Layers or 

Timeline panel.
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head (the clip activates itself when 

you start dragging and a preview 

window opens). To trim the beginning 

of a video clip, position the playhead 

where you want the video to start, 

point your cursor at the clip’s begin-

ning and when the cursor bracket 

faces rightward toward the clip, drag 

it to the playhead. Repeat this 

process for each clip.

To restore a trimmed clip, drag its 

start point leftward or its end point 

rightward. To split a clip, position the 

playhead at the desired split point, 

click the scissors icon in the Timeline 

panel, and Photoshop splits it in two. 

To delete a clip, activate it in either 

the Timeline or Layers panel and 

press Delete (PC: Backspace). To 

reposition a clip in the video, activate 

it and drag left/right in the Timeline 

panel or up/down in the Layers 

panel.

Now let’s add motion to all but the 

first still image. Click the triangle at 

the upper right of the still clips in the 

Timeline panel (increase the panel’s 

zoom level if you can’t see it). In the 

Motion menu that opens, choose Pan 

& Zoom, specify a zoom angle (say, 

20), and pick Zoom In or Zoom Out. 

Drag the playhead across the clip to 

HOW TO EDIT VIDEO IN PHOTOSHOP CCCREATE

YOU CAN CHANGE clip 

duration by adjusting 

its length. Just drag 

the bracket (circled).
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preview the motion. Repeat on the 

next still clip, and enter an opposite 

pan angle (say, –20).

ADD FINISHING TOUCHES

To create a safe space for branding 

at the end of the video, add a Solid 

Color fill layer. Click the half-black/

half-white circle at the bottom of the 

Layers panel (circled below), choose 

Solid Color, and pick black. Position 

this layer at the top of Video Group 1, 

which puts it at the end of your video, 

creating black frames onto which you 

can place text or a logo.

Now let’s add some 

transitions. Click the half-

black/half-white rectangle in 

the Timeline panel and drag 

the Fade With Black transition 

onto the beginning of the first 

clip to fade it in from black. To 

extend the transition’s length, 

point your cursor at its end (circled 

above) and drag rightward. Next, 

drag a Cross Fade transition between 

the remaining clips.

Anything inside Video Group 1 will 

play in succession, so to stack other 

content on top of it—making the other 

content play at the same time—you can 

Drag to adjust zoom level ADDING SUBTLE 

MOTION to still 

images increases 

visual interest.
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add them to another video group. This 

works for text, images, shapes, video 

clips, and adjustment layers, which are 

handy for altering clip tone and color. In 

the Timeline panel, click the filmstrip 

icon next to Video Group 1 and choose 

New Video Group. Position the play-

head atop the first clip slightly past the 

transition and press T to grab the Type 

tool. Click atop your document and add 

some text (to see the text, position the 

playhead atop the text clip). Adjust the 

duration of the text clip as described 

earlier and then add a Fade transition to 

the beginning and end of the text clip.

With the Type layer in Video Group 

2 active, choose File → Place Embed-

ded and navigate to where your logo 

lives and click Place. In the Timeline 

panel, drag the clip rightward until it’s 

at the end of the video, atop the Solid 

Color Fill layer you added earlier. 

Adjust clip position and length so it 

appears slightly after the fill layer 

transition resolves. In this example, a 

text-based logo was used. Add a 

Fade transition to the beginning and 

end of the logo or text clip.

Last but not least, add some audio. 

Click the musical notes next to the 

Audio Track in the Timeline panel and 

choose Add Audio. Navigate to the 

audio file and click Open. Position the 

audio clip as described above. To alter 

volume, or to fade audio in/out, click 

the triangle at the upper right of its clip. 

HOW TO EDIT VIDEO IN PHOTOSHOP CCCREATE
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(To match your video to audio length, 

add the audio earlier in the process.)

Tap your keyboard’s spacebar to 

play the video and then adjust clip and 

transition lengths as necessary. When 

you’re finished, choose File → Export → 

Render Video. In the resulting dialog, 

choose Adobe Media Encoder, H.264 

from the Format menu, and High 

Quality from the Preset menu, and click 

Render. You 

can view the 

final result at 

https://youtu.

be/qC-stfh-

sUnM:

As you can see, creating video in 

Photoshop is well within reach. Until 

next time, may the creative force be 

with you all! ■
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HELP DESK Answering Your Questions and Sharing Your 
Tips About Getting the Most From Your Mac

Mac 911
Solutions to your most vexing Mac problems.

BY GLENN FLEISHMAN

How to make Sidebar shortcuts for removable drives

Q: All of my Sidebar shortcuts go to folders on an external hard drive 

where I keep all my working files. I use shortcuts to these folders often, 

but when I disconnect the hard drive to pack up my laptop on the go and 

reconnect my external hard drive, the shortcuts are gone. Is there any way 

to save the shortcuts and reinstall them?

— Glenn Ruga

A: Apple treats its Sidebar shortcuts differently than the aliases you can make 

in the Finder for the desktop. Even though the document describes them as 

an alias, they’re a different sort of creature, because when you eject a volume 

on which a Sidebar shortcut exists (whether the drive itself or anything on it), 
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the shortcut disappears instantly from 

the Sidebar.

However, in testing this there’s a 

super sneaky way around this: 

Make a Finder alias of the links you 

want and Command-drag the alias 

into the Sidebar. Aliases stop 

working when the destination 

disappears, but they aren’t deleted. 

But you must keep the alias active 

somewhere on a mounted drive, or 

the Sidebar will delete it. 

1. Make a folder on your startup 

volume called Sidebar Aliases or the 

like.

2. Select an item or items, whether 

a drive, a folder, or a document, or any 

combination, from the mounted drive.

3. Hold down Command-Option 

and drag the item or items into the 

Sidebar Aliases folder. The Finder 

creates links.

4. Open the Sidebar Aliases folder 

and Command-drag all of the short-

cuts you want.

When you eject the volume, the 

Sidebar icon may switch from a drive 

or folder to a generic document icon. 

If you click it while the volume is 

ejected, you see the usual alias error 

dialog—click Cancel to dismiss it.

However, when you remount a 

drive, the aliases of which are in the 

Sidebar, you can now click them 

again and they work just the same as 

before. Hurray!

Does your AirPort Extreme 
Base Station work but is 
unreachable via AirPort 
Utility?
The other day, my wife texts me (from 

upstairs; I work in a home office in 

the basement): the printer had 

stopped working, and could I take a 

look? Our printer is connected via 

USB to an Apple AirPort Extreme 

Base Station (5th generation), which 

shares it over the network. The base 

station is an extension of a network, 

so it’s in bridging mode.

Since the green LED was lit on the 

base station, I checked out the 

printer first; it was fine. I restarted the 

base station, and it came up again 

with a green LED, but the printer still 

didn’t show up on the network. Only 

then did I use AirPort Utility to see 

what was up, and that app put up a 

yellow yield sign on top of the base 

station, and, when I clicked it, noted 

Device Not Found.

But I’m looking right at it! And its 

green light! I was able to confirm that 

the base station was routing both 

ethernet and Wi-Fi, and that my 

MAC 911HELP DESK
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to 30 minutes, during which time the 

printer re-appeared and I was able to 

print. But then it reverted to its 

previous Device Not Found status. A 

couple days after I witnessed this, a 

reader wrote in with a nearly identi-

cal experience. Querying on Twitter, 

half a dozen people said they’d had 

the same thing, but a power cycle or 

form of reset helped.

One colleague on Twitter suggested 

that removing all Apple IDs from the 

Back To My Mac configuration section 

would fix the problem. (Click a base 

station in AirPort Utility, click Edit, and 

then make changes in the Base Station 

tab. Click Update to apply changes.) I 

did another factory reset, removed the 

Apple ID, and the base station (and its 

laptop was 

connected to it. (I 

use WiFi Explorer 

for OS X ($15; 

go.macworld.com/

wifiexplorer) to 

look at local Wi-Fi 

network setups, 

and it provides 

the unique 

adapter inter-

faces, called 

BSSIDs, broadcast 

by Wi-Fi base 

stations.)

Power cycling 

didn’t help me 

out, though 

several colleagues who had the 

same problem when I polled on 

Twitter said a power cycle would fix 

this issue for a while, as long as 

several months.

I tried a soft reset and then a 

factory reset. A soft reset should 

clear any transient problems with a 

running base station; a factory one 

wipes everything, but I had no 

custom configuration on this base 

station that I needed to retain. 

(Apple’s base stations have three 

kinds of reset: soft, hard, and factory, 

which you can read about on Apple’s 

lengthy support page; go.macworld.

com/airportbaseresetfaq.)

The factory reset put the base 

station back in business for about 20 

NO! WHY???
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printer) have remained working for a 

few days so far. This does prevent 

remote access to attached drives and 

Time Capsule volumes as well as 

remote configuration.

I’ve reached out to Apple for any 

insight it may have about other fixes. 

It may need to be replaced due to 

hardware failure—but it’s fascinating 

to me that the networking part can 

work independently of the other 

subsystems.

Replace a base station 
under a Mac or Apple TV 
AppleCare warranty
Here’s a bonus tip for you related to 

Apple Wi-Fi base stations: Apple 

incudes them in AppleCare extended 

warranties purchased for Macs and 

Apple TVs, even when you didn’t buy 

the base station at the same time. 

This appears to be a little-known fact, 

but it’s spelled out in details in 

AppleCare’s terms and conditions. 

Every base station you purchased 

new as far back as two years before 

the purchase date of a new Mac is 

covered for the duration of the 

AppleCare warranty. (Read Section 

3.2, go.macworld.com/applecare4 

mac, of the U.S. terms; warranties 

vary by country.)

I purchased my base station in June 

2013, and bought a new USB-C Mac-

Book in April 2015 along with AppleC-

are. That makes that base station 

eligible for service. If my fix doesn’t 

stick, my next plan is to navigate the 

repair and replacement process.

How to find all the 
characters in a font

Q: In the old system, I could click on 

the [input palette] icon in the menu 

bar and see all the characters 

within any font that I chose, then 

double-click it to add it to my 

document. In El Capitan, that icon 

produces nothing but emoji and 

symbols. Where can I find all the 

characters within a font so I can do 

what I used to do?

— Lynn Garwood

A: In a recent Mac 911, I answered Lynn 

Garwood’s question about character 

THE OLD CHARACTER 

Palette had font 

variants at the 

bottom.
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selection when she 

upgraded from 

Mavericks to El 

Capitan. Except I 

didn’t! I read her 

question as asking 

about key combina-

tions, and pointed 

her to the Keyboard 

Viewer. Astute 

commenter 

“xploraiswakco” 

very politely noted 

that I had answered 

her question sort of, but not really the 

core of what she was asking: the 

Character Viewer had changed to the 

Emoji & Symbols palette, and no longer 

has the same approach to showing 

characters (not key combinations) in 

every font. (Thank you, xploraiswakco!)

Why don’t I go ahead and answer 

Lynn’s actual question, then?

The most likely thing she’s experi-

encing is the minimized option for the 

Characters palette, which is the floating 

window that shows up when you 

select the Input system menu’s Show 

Emoji & Symbols option. If you click the 

little palette icon in its upper right—

kaboom!—it shrinks to an emoji palette, 

and gives no indication that it’s any-

thing but that.

Click the tiny palette icon on the 

emoji palette, and it expands back to 

full size. That’s probably what Lynn 

needed. Apologies.

Here’s another part of what’s 

confusing, too. Until a few versions 

ago, the place where you could see 

YOU CAN CUSTOMIZE the Characters palette to reveal frequently used subsets.

THE EMOJI PALETTE hides the full range of characters 

available, showing just emoji and some symbols. 

Click the tiny palette in its upper right to restore the 

Characters palette.
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the full panoply of all characters 

available in various sets (along with 

versions available in locally loaded 

fonts) was called the Character 

Palette with the word Palette in the 

name. Now, when you select Show 

Emoji & Symbols the Characters 

(plural) palette shows up.

It’s a little reorganized, too, though 

the current form dates back several 

versions of OS X. You can click the 

Settings icon (gear icon → Customize 

List) to select additional character sets 

to show in the list at left, which is handy 

when you frequently need certain 

kinds of symbols, like various curren-

cies or technical/keyboard characters.

With any character selected, the 

palette shows a larger version with 

markings for cap height, descender, 

and left and right edges, as well as 

details, including the Unicode value, 

useful for embedding in Web pages 

by hand. Below that, it shows Related 

Characters, if any, and scroll down to 

see Font Variation.

If you want to insert a character from 

a given font, click the variation, which 

then shows a larger preview and the 

font name. Double-click the variation, 
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Ask Mac 911
We’ve compiled a list of the most 

commonly asked questions we get, 

and the answers to them: read our 

super FAQ (go.macworld.com/mac 

911faq) to see if you’re covered. If 

not, we’re always looking for new 

problems to solve! Email us at 

mac911@macworld.com including 

screen captures as appropriate. 

Mac 911 can’t provide direct email 

responses or answers for every 

question. For that, turn to Apple-

Care, an Apple Store Genius Bar, or 

the Apple Support Communities.

and it’s inserted at the current text-

insertion point in a document or text 

field; if the app you’re using supports 

rich text and fonts, the pasted-in 

character should be in the typeface 

shown in the Characters palette.

The same commenter reminds us 

that the Font Book built into OS X lets 

you select a font and then select 

View → Reperoire to see a font’s 

entire character set. ■ 


